
Installing driver over the network
Command- line Definition Description

/s or

/S

Starts silent installation. Installs machine drivers 
without prompting any UIs 
or user intervention.

/p”<port name>” or

/P”<port name>”

Specifies printer port.

 

Network Port will be 
created by use of 
Standard TCP/IP 
Port monitor. For 
local port, this port 
must exist on 
system before 
being specified by 
command.

 

Printer port name can be 
specified as IP address, 
hostname, USB local port 
name or IEEE1284 port 
name.

For example:

•  /p”xxx.xxx.xxx.xxx” in 
where, “xxx.xxx.xxx.xxx” 
means IP address for 
network printer. /
p”USB001”, /P”LPT1:”, /
p”hostname”

/a”<dest_path>” or

/A”<dest_path>”

Specifies destination path 
for installation.

 

The destination 
path should be a 
fully qualified path.

 

Since machine drivers 
should be installed on the 
OS specific location, this 
command applies to only 
application software.

/n”<Printer name>” 
or

/N”<Printer name>”

Specifies printer name. 
Printer instance shall be 
created as specified printer 
name.

With this parameter, you 
can add printer instances as 
you wish.

/nd or

/ND

Commands not to set the 
installed driver as a default 
machine driver.

It indicates installed 
machine driver will not be 
the default machine driver 
on your system if there are 
one or more printer drivers 
installed. If there is no 
installed machine driver on 
your system, then this 
option won’t be applied 
because Windows OS will 
set installed printer driver as 
a default machine driver.

/x or

/X

Uses existing machine 
driver files to create printer 
instance if it is already 
installed.

This command provides a 
way to install a printer 
instance that uses installed 
printer driver files without 
installing an additional 
driver.

Command- line Definition Description
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Mac

1 Make sure that the machine is connected to your computer and 
powered on.

2 Insert the supplied software CD into your CD-ROM drive.

3 Select the CD-ROM volume that appears on Finder.

4 Double-click the Install Software icon.

5 Read the license agreement and check installation agreement button.

6 Click Next.

7 Select Network on the printer connection type screen. 

8 Click Next.

9 Follow the instructions in the installation window.
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Linux

You need to download Linux software packages from the Samsung website to 
install the printer software (http://www.samsung.com  > find your product > 
Support or Downloads).

/up”<printer 
name>” or

/UP”<printer 
name>”

Removes only specified 
printer instance and not the 
driver files.

This command provides a 
way to remove only 
specified printer instance 
from your system without 
effecting other printer 
drivers. It will not remove 
printer driver files from your 
system.

/d or

/D

Uninstalls all device drivers 
and applications from your 
system.

This command will remove 
all installed device drivers 
and application software 
from your system.

/v”<share name>” or

/V”<share name>”

Shares installed machine 
and add other available 
platform drivers for Point & 
Print.

It will install all supported 
Windows OS platform’s 
machine drivers to system 
and share it with specified 
<share name> for point and 
print.

/o or 

/O

Opens Printers and Faxes 
folder after installation.

This command will open 
Printers and Faxes folder 
after the silent installation.

/h, /H or /? Shows Command-line Usage.

Command- line Definition Description
1022.  Using a Network-Connected Machine

http://www.samsung.com
http://www.samsung.com


Installing driver over the network

1 Make sure that the machine is connected to your network and powered 

on. Also, your machine’s IP address should have been set. 

2 Copy Unified Linux Driver package to your system.

3 Open Terminal program and go to the folder that you copied the

package to.

4 Extract the package.

5 Move to uld folder.

6 Execute ” ./install.sh“ command (If you are not logged in as root,

execute the command with “sudo” as “sudo ./install.sh”).

7 Proceed with installation.

8 When installation finished, launch Printing utility (Go to System > 
Administration > Printing or execute “system-config-printer“ 
command in Terminal program).

9 Click Add button.

10 Select AppSocket/HP JetDirect and enter your machine’s IP address.

11 Click Forward button and add it to your system.
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IPv6 is supported properly only in Windows Vista or higher.

 

 

If the IPv6 network seems to not be working, set all the network setting to 
the factory defaults and try again using Clear Setting.

 

The machine supports the following IPv6 addresses for network printing and 
managements.

• Link-local Address: Self-configured local IPv6 address (Address starts with 
FE80).

• Stateless Address: Automatically configured IPv6 address by a network 
router.

• Stateful Address: IPv6 address configured by a DHCPv6 server.

• Manual Address: Manually configured IPv6 address by a user.

In the IPv6 network environment, follow the next procedure to use the IPv6 
address.
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From the control panel

Activating IPv6

1 Press the  (Menu) button on the control panel.

2 Press Network > TCP/IP (IPv6) > IPv6 Activate.

3 Select On and press OK.

4 Turn the machine off and turn it on again.

 

When you install the printer driver, do not configure both IPv4 and 

IPv6. We recommend to configure either IPv4 or IPv6 (see "Installing 

driver over the network" on page 99).

 

DHCPv6 address configuration

If you have a DHCPv6 server on your network, you can set one of the following 
options for default dynamic host configuration.

1 Press the  (Menu) button on the control panel.

2 Press Network > TCP/IP (IPv6) > DHCPv6 Config.
1042.  Using a Network-Connected Machine



IPv6 configuration

3 Press OK to select the required value you want.

• DHCPv6 Addr.: Always use DHCPv6 regardless of router request.

• DHCPv6 Off: Never use DHCPv6 regardless of router request.

• Router: Use DHCPv6 only when requested by a router.
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From the SyncThru™ Web Service

Activating IPv6

1 Access a web browser, such as Internet Explorer, from Windows. Enter 
the machine IP address (http://xxx.xxx.xxx.xxx) in the address field and 
press the Enter key or click Go.

2 If it’s your first time logging into SyncThru™ Web Service you need to 
log-in as an administrator. Type in the below default ID and password. 
We recommend you to change the default password for security 
reasons.

• ID: admin

• Password: sec00000 

3 When the SyncThru™ Web Service window opens, move the mouse 
cursor over the Settings of the top menu bar and then click Network 
Settings.

4 Click TCP/IPv6 on the left pane of the website.

5 Check the IPv6 Protocol check box to activate IPv6.

6 Click the Apply button.

7 Turn the machine off and turn it on again.

 

• You can also set the DHCPv6.

• To manually set the IPv6 address:
Check the Manual Address check box. Then, the Address/Prefix text 
box is activated. Enter the rest of the address 
(e.g.,:3FFE:10:88:194::AAAA. “A” is the hexadecimal 0 through 9, A 
through F).

 

IPv6 address configuration

1 Start a web browser, such as Internet Explorer, that supports IPv6 
addressing as a URL.

2 Select one of the IPv6 addresses (Link-local Address, Stateless 
Address, Stateful Address, Manual Address) from Network 
Configuration Report (see "Printing a network configuration report" on 
page 96).

• Link-local Address: Self-configured local IPv6 address (Address 
starts with FE80).

• Stateless Address: Automatically configured IPv6 address by a 
network router.
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• Stateful Address: IPv6 address configured by a DHCPv6 server.

• Manual Address: Manually configured IPv6 address by a user.

3 Enter the IPv6 addresses (e.g.,: http://[FE80::215:99FF:FE66:7701]).

 

Address must be enclosed in '[ ]' brackets.
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• Wireless networking may not be available depending on the model (see 
"Features by model" on page 6).

 

Wireless networks require higher security, so when an access point is first set up, 
a network name (SSID), the type of security used, and a Network Password are 
created for the network. Ask your network administrator about this information 
before proceeding with the machine installation.
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Introducing wireless set up methods

You can set wireless settings either from the machine or the computer. Choose 
the setting method from the below table.

 

• Some wireless network installation types may not be available 
depending on the model or country.

• It is strongly recommended that you set the password on Access Points. 
If you do not set the password on Access Points, they might be exposed 
to illegal access from unknown machines including PCs, smart phones 
and printers. Refer to the Access Point user' guide for password settings.

 

Set up 
method

Connecting 
method

Description & Reference

With Access 
Point

From the 
computer

See "Setting up via USB cable" on page 110 
for Window.

See "Access point without a USB cable" on 
page 112 for Window.

See "Setting up via USB cable" on page 114 
for Mac.

See "Access point without a USB cable" on 
page 115 for Mac.

See "Using a network cable" on page 116.

From the 
machine’s control 
panel

See "Using the WPS Settings menu" on 
page 108.

See "Using the Wi-Fi Networks" on page 
109.

Wi-Fi Direct setup
See "Setting the Wi-Fi Direct for mobile 
printing" on page 118.
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Using the WPS Settings menu 

If your machine and access point (or wireless router) support Wi-Fi Protected 
Setup™ (WPS), then you can easily configure the wireless network settings 
through the WPS button menu without the need for a computer.

 

• If you want to use the wireless network using the infrastructure mode, 
make sure that the network cable is disconnected from the machine. 
Using the WPS (PBC) button or entering the PIN from the computer to 
connect to the access point (or wireless router) varies depending on the 
access point (or wireless router) you are using. Refer to the user's guide 
of the access point (or wireless router) you are using.

• When using the WPS button to set the wireless network, security settings 
may change. To prevent this, lock the WPS option for the current wireless 
security settings. The option name may differ depending on the access 
point (or wireless router) you are using.

 

Items to prepare

• Check if the access point (or wireless router) supports Wi-Fi Protected 
Setup™ (WPS).

• Check if your machine supports Wi-Fi Protected Setup™ (WPS).

• Networked computer (PIN mode only)

Choosing your type

There are two methods available to connect your machine to a wireless network.

• The Push Button Configuration (PBC) method allows you to connect your 
machine to a wireless network by pressing both the WPS  button menu on 
the control panel of your machine and the WPS (PBC) button on a Wi-Fi 
Protected Setup™ WPS-enabled access point (or wireless router) 
respectively.

• The Personal Identification Number (PIN) method helps you connect your 
machine to a wireless network by entering the supplied PIN information on 
a Wi-Fi Protected Setup™ WPS-enabled access point (or wireless router).
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Connecting WPS

Factory default in your machine is PBC mode, which is recommended for a 
typical wireless network environment.

Connecting in PBC mode

1 Press the  (Menu) button on the control panel and select Network > 
Wireless > WPS Settings > Connect via PBC.

2 Press the WPS (PBC) button on the access point (or wireless router).

3 Follow the instruction on the display screen.

The messages are displayed on the display screen

Connecting in PIN mode

1 Press Network > Wireless  > WPS Settings > Connect via PIN.

2 The eight-digit PIN appears on the display. 

You need to enter the eight-digit PIN within two minutes on the 
computer that is connected to the access point (or wireless router).

3 Follow the instruction on the display screen.

The messages are displayed on the display screen
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Using the Wi-Fi Networks

Before starting, you will need to know the network name (SSID) of your wireless 
network and the network key if it is encrypted. This information was set when 
the access point (or wireless router) was installed. If you do not know about your 
wireless environment, please ask the person who set up your network.

1 Press the  (Menu) button on the control panel and select Network 
>Wi-Fi ON/OFF then ON from the display screen.

2 The machine will display a list of available networks from which to 
choose. After a network is chosen then printer will prompt for the 
corresponding security key.

3 Select the Wi-Fi network option you want.

13 

Setup using Windows

 

Shortcut to the Samsung Easy Wireless Setup program without the CD: If 
you have installed the printer driver once, you can access the Samsung 
Easy Wireless Setup program without the CD.
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Setting up via USB cable

Items to prepare

• Access point

• Network-connected computer

• Software CD that was provided with your machine

• A machine installed with a wireless network interface

• USB cable

Creating the infrastructure network

1 Check wheter the USB cable is connected to the machine.

2 Turn on your computer, access point, and machine.

3 Insert the supplied software CD into your CD-ROM drive.

If the installation window does not appear, click Start > All programs > 
Accessories > Run.

X:\Setup.exe replacing “X” with the letter, which represents your CD-
ROM drive and click OK.

• For Windows 8,

If the installation window does not appear, from Charms, select 
Search > Apps and search for Run. Type in X:\Setup.exe, replacing 
“X” with the letter that represents your CD-ROM drive and click OK.

If “Tap to choose what happens with this disc.” pop-up window 
appears, click the window and select Run Setup.exe.

4 Review and accept the installation agreements in the installation 
window. Then, click Next.

5 Select Wireless on the Printer Connection Type screen. Then, click 
Next.
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6 On the Are you setting up your printer for the first time? screen, select 

Yes, I will set up my printer's wireless network. Then, click Next.

If your printer is already connected on the network, select No, my 
printer is already connected to my network.

7 Select Using a USB cable on the Select the Wireless Setup Method 
screen. Then, click Next.

8 After searching, the window shows the wireless network devices. Select 
the name (SSID) of the access point you want to use and click Next.

 

If you cannot find the network name you want to choose, or if you want to 
set the wireless configuration manually, click Advanced Setting.

• Enter the wireless Network Name: Enter the SSID of the access point 
(SSID is case-sensitive).

• Operation Mode: Select Infrastructure.

• Authentication: Select an authentication type.
Open System: Authentication is not used, and encryption may or may 
not be used, depending on the need for data security.
Shared Key: Authentication is used. A device that has a proper WEP key 
can access the network.
WPA Personal or WPA2 Personal: Select this option to authenticate the 
print server based on a WPA Pre-Shared Key. This uses a shared secret key 
(generally called Pre Shared Key pass phrase), which is manually 
configured on the access point and each of its clients.

• Encryption: Select the encryption (None, WEP64, WEP128, TKIP, AES, 
TKIP AES).

• Network Password: Enter the encryption network password value.

• Confirm Network Password: Confirm the encryption network 
password value.

• WEP Key Index: If you are using WEP Encryption, select the appropriate 
WEP Key Index.

 

 

The wireless network security window appears when the access point has 
security settings.

Enter the Network Password of the access point (or router).
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9 If your printer supports Wi-Fi Direct, the following screen appears.

Click Next.

 

• Wi-Fi Direct option appears on the screen only if your printer supports 
this feature.

• Can start to build Wi-Fi Direct by using Samsung Easy Printer Manager 
(see "Setting up Wi-Fi Direct" on page 118).

• Wi-Fi Direct Name: The default Wi-Fi Direct Name is the model name 
and the maximum length is 22 characters.

• Password setting is the numeric string, and the size is 8 ~ 64 characters.

 

10 When the wireless network set up is completed, disconnect the USB 
cable between the computer and machine. Click Next.

11 Select the components to be installed.

12 Follow the instructions in the installation window.

Access point without a USB cable

Items to prepare

• WiFi-enabled PC running Windows 7 or higher and an access point (router)

• Software CD that was provided with your machine

• A machine installed with a wireless network interface

 

While setting the wireless network, the machine uses PC's wireless LAN. You 
might not be able to connect to the Internet. 
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Creating the infrastructure network

1 Turn on your computer, access point, and machine.

2 Insert the supplied software CD into your CD-ROM drive.

If the installation window does not appear, click Start > All programs > 
Accessories > Run.

X:\Setup.exe replacing “X” with the letter, which represents your CD-
ROM drive and click OK.

• For Windows 8,

If the installation window does not appear, from Charms, select 
Search > Apps and search for Run. Type in X:\Setup.exe, replacing 
“X” with the letter that represents your CD-ROM drive and click OK.

If “Tap to choose what happens with this disc.” pop-up window 
appears, click the window and select Run Setup.exe.

3 Review and accept the installation agreements in the installation 
window. Then, click Next.

4 Select Wireless on the Printer Connection Type screen. Then, click 
Next.

5 On the Are you setting up your printer for the first time? screen, select 
Yes, I will set up my printer's wireless network. Then, click Next.

If your printer is already connected on the network, select No, my 
printer is already connected tomy network.

6 Select Using a direct wireless connection on the Select the Wireless 
Setup Method screen. Then, click Next.

 

• Even if your computer is running Windows 7 or higher, you cannot use 
this feature if your PC does not support wireless network. Set the wireless 
network using a USB cable (see "Setting up via USB cable" on page 110).

• If below screen appears, press the  (WPS) button from the control 
panel within 2 minutes.
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7 When the wireless network set up is completed, click Next. 

8 Follow the instructions in the installation window.

14 

Setup using Mac

Items to prepare

• Access point

• Network-connected computer

• Software CD that was provided with your machine

• A machine installed with a wireless network interface

• USB cable

Setting up via USB cable

1 Make sure that the machine is connected to your computer and

powered on.

2 Insert the supplied software CD into your CD-ROM drive.

3 Select the CD-ROM volume that appears on Finder.

4 Double-click Install Software icon.

5 Read the license agreement and check installation agreement button.

6 Click Next

7 Select Wireless on the Printer Connection Type

8 Click Next

9 If the installer asks you to allow access to the keychain, click Deny.

 

If you clicked Always Allow in this step, the Select a wireless printer 
window appears without asking for access to the keychain. If this occurs, 
click Cancel in the Select a wireless printer window.

 

10 On the Select the Wireless Setup Method screen, select Using a USB 
cable, and then click Next.

If the screen dose not appear, go to step 14.

11 After searching, the window shows the wireless network devices. Select 
the name (SSID) of the access point you want to use and click Next.

 

When you set the wireless configuration manually, click Advanced Setting.

• Enter the wireless Network Name: Enter the SSID of the access point 
(SSID is case-sensitive).

• Operation Mode: Select Infrastructure.
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• Authentication: Select an authentication type.

Open System: Authentication is not used, and encryption may or may 
not be used, depending on the need for data security.
Shared Key: Authentication is used. A device that has a proper WEP key 
can access the network.
WPA Personal or WPA2 Personal: Select this option to authenticate the 
print server based on the WPA Pre-Shared Key. This uses a shared secret 
key (generally called Pre Shared Key pass phrase) that is manually 
configured on the access point and each of its clients.

• Encryption: Select the encryption. (None, WEP64, WEP128, TKIP, AES)

• Network Key: Enter the encryption network key value.

• Confirm Network Key: Confirm the encryption network key value.

• WEP Key Index: If you are using WEP Encryption, select the appropriate 
WEP Key Index.

The wireless network security window appears when the access point has 
security enabled.

Enter the Network Key of the access point (or router).

 

12 The window showing the wireless network setting appears. Check the 
settings and click Next.

 

• Can start to build Wi-Fi Direct by using Samsung Easy Printer Manager 
(see "Setting up Wi-Fi Direct" on page 118).

• Wi-Fi Direct Name: The default Wi-Fi Direct Name is the model name 
and the maximum length is 22 characters.

• Password setting is the numeric string, and the size is 8 ~ 64 characters.

 

13 The Wireless Network Setting Complete window appears. Click Next.

14 When the wireless network settings are completed, disconnect the USB 
cable between the computer and machine. Click Next.

15 Follow the instructions in the installation window.

Access point without a USB cable

Items to prepare

• WiFi-enabled Mac running Mac OS 10.7 or higher and an access point 
(router)

• Software CD that was provided with your machine

• A machine installed with a wireless network interface

1 Make sure that the machine is connected to your computer and

powered on.

2 Insert the supplied software CD into your CD-ROM drive.

3 Select the CD-ROM volume that appears on Finder.

4 Double-click Install Software icon.

5 Read the license agreement and check installation agreement button.

6 Click Next.
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7 Select Wireless on the Printer Connection Type screen.

8 Click Next.

9 If the installer asks you to allow access to the keychain, click Allow.

10 If the Select a wireless printer window appears, select the printer 
named DIRECT-xxx.

 

If the Press WPS button on your printer screen appears, press the  

(WPS) button from the control panel within 2 minutes.

 

11 When the wireless network set up is complete, follow the instructions in 
the installation window.
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Using a network cable

 

See your network administrator, or the person that set up your wireless 
network, for information about your network configuration.

 

Your machine is a network compatible machine. To enable your machine to 
work with your network, you will need to perform some configuration 
procedures.

Items to prepare

• Access point

• Network-connected computer

• Software CD that was provided with your machine

• A machine installed with a wireless network interface

• Network cable

Printing a network configuration report

You can identify the network settings of your machine by printing a network 
configuration report.

See "Printing a network configuration report" on page 96.

IP setting using SetIP Program (Windows)

This program is used to manually set the network IP address of your machine 
using its MAC address to communicate with the machine. The MAC address is 
the hardware serial number of the network interface and can be found in the 
Network Configuration Report. 

See "Printing a network configuration report" on page 96.
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Configuring the machine’s wireless network

Before starting you will need to know the network name (SSID) of your wireless 
network and the network key if it is encrypted. This information was set when 
the access point (or wireless router) was installed. If you do not know about your 
wireless environment, please ask the person who set up your network.

To configure wireless parameters, you can use SyncThru™ Web Service.

Using SyncThru™ Web Service

Before starting wireless parameter configuration, check the cable connection 
status. 

1 Check whether or not the network cable is connected to the machine. If 
not, connect the machine with a standard network cable.

2 Start a web browser such as Internet Explorer, Safari, or Firefox and enter 
your machine’s new IP address in the browser window.

For example,

3 Click Login on the upper right of the SyncThru™ Web Service website.

4 If it’s your first time logging into SyncThru™ Web Service you need to 
log-in as an administrator. Type in the below default ID and password. 
We recommend you to change the default password for security 
reasons.

• ID: admin 

• Password: sec0000

5 When the SyncThru™ Web Service window opens, click Network 
Settings.

6 Click Wi-Fi > Wizard.

7 Select the one Network Name(SSID) in the list.

8 Click Next.

If the wireless security setting window appears, enter the registered 
password (network password) and click Next.

9 The confirmation window appears, please check your wireless setup. If 
the setup is right, click Apply.
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Turning the Wi-Fi network on/off

1 Check whether the network cable is connected to the machine. If not, 
connect the machine with a standard network cable.

2 Start a web browser such as Internet Explorer, Safari, or Firefox and enter 
your machine’s new IP address in the browser window.

For example,

3 Click Login on the upper right of the SyncThru™ Web Service website.

4 If it’s your first time logging into SyncThru™ Web Service you need to 
log-in as an administrator. Type in the below default ID and password. 
We recommend you to change the default password for security 
reasons.

• ID: admin 

• Password: sec00000

5 When the SyncThru™ Web Service window opens, click Network 
Settings.

6 Click Wi-Fi.

7 You can turn the Wi-Fi network on/off.
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Setting the Wi-Fi Direct for mobile printing

Wi-Fi Direct is a secure and easy-to-use peer-to-peer connection between a Wi-
Fi Direct-enabled printer and mobile device.

With Wi-Fi Direct, you can connect your printer to a Wi-Fi Direct network while 
concurrently connecting to an access point. You can also use a wired network 
and a Wi-Fi Direct network simultaneously so multiple users can access and print 
documents both from Wi-Fi Direct and from a wired network.

 

• You cannot connect your mobile device to the internet through the 
printer’s Wi-Fi Direct.

• The supported protocol list may differ from your model, Wi-Fi Direct 
networks do NOT support IPv6, network filtering, IPSec, WINS, and SLP 
services. 

• The maximum number of devices that can be connected via Wi-Fi Direct 
is 4.

 

Setting up Wi-Fi Direct

You can enable Wi-Fi Direct feature by one of the following methods.
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From the machine

1 Press the  (Menu) button on the control panel and select Network > 
Wireless >Wi-Fi Direct from the display screen.

2 Tap Wi-Fi Direct.

3 Enable Wi-Fi Direct.

From the network-connected computer

If your printer is using a network cable or a wireless access point, you can enable 
and configure Wi-Fi Direct from SyncThru™ Web Service.

1 Access SyncThru™ Web Service and select Settings > Network 
Settings > Wi-Fi > Wi-Fi Direct™.

2 Enable Wi-Fi Direct™ and set other options.

Setting up the mobile device

• After setting up Wi-Fi Direct from the printer, refer to the user manual of the 
mobile device you are using to set its Wi-Fi Direct.

• After setting up Wi-Fi Direct, you need to download the mobile printing 
application (For example: Samsung Mobile printer) to print from your 
smartphone.

 

• When you have found the printer you want to connect to from your 
mobile device, select the printer and the printer's LED will blink. Press the 
WPS button on the printer and it will be connected to your mobile 
device.

•  If your mobile device does not support Wi-Fi Direct, you need to enter 
the "Network Key" of a printer instead of pushing the WPS button.
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Troubleshooting

Problems during setup or driver installation

Printers Not Found

• Your machine may not be turned on. Turn on your computer and the 
machine.

• USB cable is not connected between your computer and machine. Connect 
the machine to your computer using the USB cable.

• The machine does not support wireless networking. Check the machine's 
user's guide included on the software CD supplied with your machine and 
prepare a wireless network machine.
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Connecting Failure - SSID Not Found

• The machine is unable to find the network name (SSID) you have selected or 
entered. Check the network name (SSID) on your access point and try 
connecting again. 

• Your access point is not turned on. Turn on your access point.
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Connecting Failure - Invalid Security

• Security is not configured correctly. Check the configured security on your 
access point and machine.

Connecting Failure - General Connection Error

• Your computer is not receiving a signal from your machine. Check the USB 
cable and your machine’s power.

Connecting Failure - Connected Wired Network

• Your machine is connected with a wired network cable. Remove the wired 
network cable from your machine.

Connecting Failure - Assigning the IP address

• Cycle the power for the access point (or wireless router) and machine.

PC Connection Error

• The configured network address is unable to connect between your 
computer and machine.

- For a DHCP network environment

The receives the IP address automatically (DHCP) when computer is 
configured to DHCP.

 

If the printing job is not working in DHCP mode, the problem may be caused 
by the automatically changed IP address. Compare the IP address between 

the product's IP address and the printer port's IP address.

How to compare:
1 Print the network information report of your printer, and then check the 

IP address (see "Printing a network configuration report" on page 96).
2 Check the printer port's IP address from your computer.

a Click the Windows Start menu. 

• For Windows 8, from the Charms, select Search > Settings.
b For Windows XP Service Pack 3/Server 2003, select Printer and Faxes. 

• For Windows Server 2008/Vista, select Control Panel > Hardware 
and Sound > Printers. 

• For Windows Server 2008 R2, select Control Panel > Hardware > 
Devices and Printers. 

• For Windows 7/ Windows 8, select Control Panel > Devices and 
Printers. 

c Right-click your machine.
d For Windows XP Service Pack 3/2003/2008/Vista, press Properties.

For Windows 7/ Windows 8 or Windows Server 2008 R2, from context 
menus, select the Printer properties.
If Printer properties item has ► mark, you can select other printer 
drivers connected with selected printer.

e Click Port tab.
f Click Configure Port.. button.
g Check if Printer Name or IP Address: is the IP address on the network 

configuration Sheet.
3 Change the printer port's IP address if it is different from the network 

information report's.
If you want to use the software installation CD to change the port IP, 
connect to a network printer. Then reconnect the IP address.
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- For a Static network environment

The machine uses the static address when the computer is configured 
to static address.

For example,

If the computer’s network information is as shown below:

▪ IP address: 169.254.133.42

▪ Subnet Mask: 255.255.0.0

Then the machine’s network information should be as below:

▪ IP address: 169.254.133.43

▪ Subnet Mask: 255.255.0.0 (Use the computer’s subnet mask.)

▪ Gateway: 169.254.133.1

Other problems

If problems occur while using the machine on a network, check the following: 

 

For information on the access point (or wireless router), refer to its own 
user's guide. 

 

• You cannot enable wired and wireless networks at the same time.

• Your computer, access point (or wireless router), or machine may not be 
turned on.

• Check the wireless reception around the machine. If the router is far from 
the machine or there is an obstacle, you might have difficulty receiving the 
signal. 

• Cycle the power for the access point (or wireless router), machine, and 
computer. Sometimes cycling the power can recover network 
communication.

• Check whether firewall software (V3 or Norton) is blocking the 
communication. 

If the computer and the machine are connected on the same network and it 
cannot be found when searching, firewall software might be blocking the 
communication. Refer to the user's guide for the software to turn it off and 
try searching for the machine again.

• Check whether the machine's IP address is allocated correctly. You can 
check the IP address by printing the network configuration report.

• Check whether the access point (or wireless router) has a configured 
security (password). If it has a password, refer to the access point (or wireless 
router) administrator.

• Check the machine's IP address. Reinstall the machine driver and change the 
settings to connect to the machine on the network. Due to the 
characteristics of DHCP, the allocated IP address could change if the 
machine is not used for a long time or if the access point has been reset.

Register the product's MAC address when you confogure the DHCP server 
on the access point (or wireless router). Then you can always use the IP 
address that is set with the MAC address. You can identify the Mac address 
of your machine by printing a network configuration report (see "Printing a 
network configuration report" on page 96).
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• Check the wireless environment. You might not be able to connect to the 

network in the infrastructure environment where you need to type in a 
user's information before connecting to the access point (or wireless router).

• This machine only supports IEEE 802.11 b/g/n and Wi-Fi. Other wireless 
communication types (e.g., Bluetooth) are not supported.

• You cannot use infrastructure mode at the same time for Samsung wireless 
network machines.

• The machine is within the range of the wireless network.

• The machine is located away from obstacles that could block the wireless 
signal.

Remove any large metal objects between the access point (or wireless 
router) and the machine.

Make sure the machine and wireless access point (or wireless router) are not 
separated by poles, walls, or support columns containing metal or concrete.

• The machine is located away from other electronic devices that may 
interfere with the wireless signal.

Many devices can interfere with the wireless signal, including a microwave 
oven and some Bluetooth devices.

• Whenever the configuration of your access point (or wireless router) 
changes, you must do the product's wireless network setup again.

• The maximum number of device that can be connected via Wi-Fi Direct is 3.

• If Wi-Fi Direct is ON, this machine only supports IEEE 802.11 b/g.

• If the access point is set to work with the 802.11n standard only, it may not 
connect to your machine.
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What is Samsung Mobile Print?

Samsung Mobile Print is a free application that enables users to print photos, 
documents, and web pages directly from your smartphone or tablet. Samsung 
Mobile Print is not only compatible with your Android and iOS smart phones 
but also with your iPod Touch and tablet PC. It connects your mobile device to a 
network connected Samsung printer or to a wireless printer through a Wi-Fi 
access point. Installing a new driver or configuring network settings isn’t 
necessary – just simply install the Samsung Mobile Print application, and it will 
automatically detect compatible Samsung printers. Besides printing photos, 
web pages, and PDFs, scanning is also supported. If you have a Samsung 
multifunction printer, scan any document into a JPG, PDF, or PNG format for 
quick and easy viewing on your mobile device. 
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Downloading Samsung Mobile Print

To download Samsung Mobile Print, go to the application store (Samsung 
Apps, Play Store, App Store) on your mobile device, and just search for 
“Samsung Mobile Print.” You can also visit iTunes for Apple devices on your 
computer.
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Supported Mobile OS 

• Android OS 2.3 or higher 

• iOS 4.0 or higher
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Using the NFC feature

The NFC(Near Field Communication) printer allows you to directly print from 
your cell phone just by holding your cell phone over the NFC tag on your printer. 
It does not require installing print driver or connecting to an access point. You 
just need NFC supported cell phone. In order to use this feature, Samsung 
Mobile Print app needs to be installed on your cell phone. 

 

• Depending on the material of the cell phone cover, NFC recognition may 
not work properly.

• Depending on the cell phone you are using, the tranmission speed may 
differ.
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Requirements

• NFC and Wi-Fi Direct enabled, Mobile Print app installed cell phone with 
Android OS 4.0 or higher.

 

Only Android OS 4.1 or higher will automatically enable the Wi-Fi Direct 
feature on your cell phone when you enable the NFC feature. We 
recommend you to upgrade your cell phone to Android OS 4.1 or higher to 
use the NFC feature.

 

• Wi-Fi Direct feature enabled printer. Wi-Fi Direct feature is enabled by 
default.
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Printing

1 Check that NFC and Wi-Fi Direct feature are enabled on your cell phone 

and Wi-Fi Direct feature is enabled on your printer (see "Setting up Wi-Fi 
Direct" on page 118). 

2 Tag the NFC antenna on your cell phone (usually located on the back of 
the cell phone) over the NFC tag( ) on your printer.

Wait few seconds for the Samsung Mobile Print app to start.

 

• For some cell phones, NFC antenna might not be located at the back of 
the cell phone. Check the location of the NFC antenna on your cell phone 
before tagging.

• If error message about changed PIN number appears, enter a changed 
PIN number and press OK. Follow the instruction on the app screen to 
update the PIN number. 

• If you do not have Samsung Mobile Print app installed on your cell 
phone, it automatically connects to Samsung Mobile Print app 
download page. Download the app and try again. 
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3 Select the content you want to print.

If neccessary, change the print option by pressing the .

4 Tag the NFC antenna on your cell phone(usually located on the back of 
the cell phone) over the NFC tag( ) on your printer.

Wait few seconds for the cell phone to connect to the printer.

 

• For some cell phones, NFC antenna might not be located at the back of 
the cell phone. Check the location of the NFC antenna on your cell phone 
before tagging.

• If error message about changed PIN number appears, enter a changed 
PIN number and press OK. Follow the instruction on the app screen to 
update the PIN number. 

 

5 The printer starts printing.
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Registering Google Cloud Printer

1 Check that NFC and Wi-Fi Direct features are enabled on your mobile 
device and Wi-Fi Direct feature is enabled on your printer. 

2 Tag the NFC tag on your mobile device (usually located on the back of 
the mobile device) over the NFC tag( ) on your printer.

Wait a few seconds for the Samsung Mobile Print app to start.

 

• For some mobile devices, NFC tag might not be located at the back of the 
mobile device. Check the location of the NFC antenna on your mobile 
device before tagging.

• If error message about changed PIN number appears, enter a changed 
PIN number and press OK. Follow the instruction on the app screen to 
update the PIN number. 

• If your do not have Samsung Mobile Print app installed on your mobile 
devices, it automatically connects to Samsung Mobile Print app 
download page. Download the app and try again.
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3 Select device status icon.

4 Select Google Cloud Print > Register Google Cloud Printer.

5 Tag the NFC tag on your mobile device (usually located on the back of 
the mobile device) over the NFC tag( ) on your printer.

Wait a few seconds for the mobile device to connect to the printer.

 

• For some mobile devices, NFC tag might not be located at the back of the 
mobile device. Check the location of the NFC antenna on your mobile 
device before tagging.

• If error message about changed PIN number appears, enter a changed 
PIN number and press OK. Follow the instruction on the app screen to 
update the PIN number. 

 

6 Confirm your printer in pop-up window.

Now your printer is registered with Google Cloud Print™ service
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Mopria™

 

Only Mopria-certified machines can use the Mopria feature. Check the box 
that your machine came in for the Mopria-certified logo.
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Setting up the machine for Mopria printing

Bonjour(mDNS) and IPP protocols are required on your machine to use the 
Mopria feature. Perform the following steps to enable the Mopria feature. 

1 Ensure that the machine is connected to the network.

2 On your computer, open a web browser (Internet Explorer, Safari, or 
Firefox) and type the IP address of the machine in the address bar. Then, 
press Enter.

For example,

3 Click Login in the upper right corner of the SyncThru™ Web Service 
website.

4 If it’s your first time logging into SyncThru™ Web Service you need to 
log-in as an administrator. Type in the below default ID and Password. 
We recommend you to change the default password for security 
reasons.

• ID: admin

• Password: sec00000 

5 When the SyncThru™ Web Service window opens, click Settings > 
Network Settings > Standard TCP/IP, LPR, IPP > IPP. Then, select 
Enable.

6 Click Settings > Network Settings > mDNS. Then, select Enable.

7 Click Security > System Security > Feature Management > Mopria. 
Then, select Enable.
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Setting up Mopria on your mobile device

If you do not have Mopria Print Service app installed on your mobile device, 
open to the app store (Play Store, App Store) on your mobile device, search 
for,Mopria Print Service, and then download and install the app.

Mopria™ Print Service is a mobile printing solution that enhances 
the new print functionality on any Android phone or tablet 
(Android version 4.4 or later). With this service, you can connect 
and print to any Mopria-certified printer on the same network as 
your mobile device without additional set-up. Many native 
Android apps support printing, including Chrome, Gmail, Gallery, 
Drive and Quickoffice.
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1 In the Settings menu of your Android device, tap Printing.

 

The location of this option may differ depending on your mobile device. If 
you cannot locate the Printing option, refer to the user's manual for your 
mobile device.

 

2  Under Print Services, tap Mopria Print Service.

3 Tap the On/Off slider to enable the Mopria Print Service. 
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Printing via Mopria

To print via Mopria on an Android device:

1 Open the email, photo, web page, or document that you want to print.

2 Tap Print on the menu in the app.

3 Select your printer, and then configure the print options.

4 Touch Print again to print the document.

 

To cancel a print job: Select and delete the document from the print queue 
in the Notification Bar.
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AirPrint

 

Only AirPrint certified machines can use the AirPrint feature. Check the box 
your machine came in for the AirPrint certified mark.
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Setting up AirPrint

Bonjour(mDNS) and IPP protocols are required on your machine to use the 
AirPrint feature. You can enable the AirPrint feature by one of the following 
methods.

1 Check whether the machine is connected to the network.

2 Start a web browser such as Internet Explorer, Safari, or Firefox and enter 
your machine’s new IP address in the browser window.

For example,

3 Click Login in the upper right of the SyncThru™ Web Service website.

4 If it’s your first time logging into SyncThru™ Web Service you need to 
log-in as an administrator. Type in the below default ID and Password. 
We recommend you to change the default password for security 
reasons.

• ID: admin

• Password: sec00000 

5 When the Embedded Web Service window opens, click Settings > 
Network Settings.

6 Click Raw TCP/IP, LPR, IPP or mDNS.

You can enable the IPP protocol or mDNS protocol.
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Printing via AirPrint

For example, the iPad manual provides these instructions:

1 Open your email, photo, web page, or document you want to print.

2 Touch the action icon( ).

3 Select your printer driver name and option menu to set up.

4 Touch Print button. Print it out.

AirPrint allows you to wirelessly print directly from iPhone, iPad and 
iPod touch running the latest version of iOS.
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Cancelling print job: To cancel the printing job or view the print summary, 

click the print center icon ( ) in multitasking area. You can click cancel in 

the print center.
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Samsung Cloud Print is a free cloud service that allows you to print or scan from 
your smartphone or tablet to your Samsung printer or MFP. After installing the 
Samsung Cloud Print app, you can register with the Samsung Cloud Print service 
just using your mobile number for authentication. No other account login is 
required, although you can link the app to your Samsung Account if you wish.

 

If you press the ( ) button from Samsung Cloud Print app, Your mobile 

device and printer or MFP can be paired , QR code, or by manually entering 
its MAC address. Once paired, you can print or scan from anywhere and 
everywhere.
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Registering your Printer to Samsung Cloud server

Registering from Web Browser

 

Make sure the printer machine is turned on and connected to a wired or 
wireless network that has access to the Internet. 

 

1 Open Web browser.

2 Enter your printer’s IP address in the address field and press the Enter key 
or click Go.

3 Click Login in the upper right corner of the SyncThru™ Web Service 
website.

4 If it’s your first time logging into SyncThru™ Web Service you need to 
log-in as an administrator. Type in the below default ID and Password. 
We recommend you to change the default password for security 
reasons.

• ID: admin

• Password: sec00000 

 

If you want to create a new user or change the password, see "Security tab" 
on page 160.

 

5 When the SyncThru™ Web Service window opens, click Settings > 
Network Settings > Samsung Cloud Print.

6 Enable Samsung Cloud Print Protocol.

7 Now your printer is registered with Samsung Cloud Print service.
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Printing with Samsung Cloud Print

 

Make sure the printer is turned on and connected to a wired or wireless 
network that has access to the Internet. 

 

Registering a printer from an application on mobile 
device

The following steps are an example of using the Samsung Cloud Print app from 
Android mobile phone.

1 Open Samsung Cloud Print app.

 

If you do not have Samsung Cloud Print app installed on your cellphone, 
go to the application store (Samsung Apps, Play Store, App Store) on your 
mobile device, and just search for download the  app and try again.

 

2 Press the ( ) button from Samsung Cloud Print app.

3 Your mobile device and printer or MFP can be paired NFC tapping, QR 
code or by manually entering its MAC address.

Printing from an application on mobile device

The following steps are an example of using the Samsung Cloud Print app from 
Android mobile phone.

1 Open Samsung Cloud Print app.

 

If you do not have Samsung Cloud Print app installed on your cellphone, 
go to the application store (Samsung Apps, Play Store, App Store) on your 
mobile device, and just search for download the  app and try again.

 

2 Tap the option check button of the document that you want to print.

3 Set the printing options if you want.

4 Tap Send Job.
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Google Cloud Print™ is a service that allows you to print to a printer using your 

smart phone, tablet, or any other web-connected devices. Just register your 
Google account with the printer, and you are ready to use the Google Cloud 
Print service. You can print your document or email with Chrome OS, Chrome 
browser, or a Gmail™/ Google Docs™ application on your mobile device, so you 

don’t need to install the printer driver on the mobile device. Refer to the Google 
website (http://support.google.com/cloudprint) for more information about 
Google Cloud Print.

32 

Registering your Google account to the printer

 

• Make sure the printer machine is turned on and connected to a wired or 
wireless network that has access to the Internet. 

• You should create your Google account in the advance. 

 

1 Open the Chrome browser.

2 Visit www.google.com.

3 Sign in to the Google website with your Gmail address.

4 Enter your printer’s IP address in the address field and press the Enter key 
or click Go.

5 Click Login in the upper right corner of the SyncThru™ Web Service 
website.

6 If it’s your first time logging into SyncThru™ Web Service you need to 
log-in as an administrator. Type in the below default ID and Password. 
We recommend you to change the default password for security 
reasons.

• ID: admin

• Password: sec00000 

 

If the network environment is using a proxy server, you need to configure 
the proxy’s IP and port number from Settings > Network Settings > 
Google Cloud Print > Proxy Setting. Contact your network service 
provider or network administrator for more information. 

 

7 When the SyncThru™ Web Service window opens, click Settings > 
Network Settings > Google Cloud Print.

8 Enter your printer’s name and description.

9 Click Register.

The confirmation pop-up window appears.

 

If you set the browser to block pop-ups, the confirmation window will not 
appear. Allow the site to show pop-ups. 
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Google Cloud Print™

10 Click Finish printer registration.

11 Click Manage your printers.

Now your printer is registered with Google Cloud Print service.

Google Cloud Print-ready devices will appear in the list.
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Printing with Google Cloud Print™

The printing procedure varies depending on the application or the device you 

are using. You can see the application list that supports Google Cloud Print 
service.

 

Make sure the printer is turned on and connected to a wired or wireless 
network that has access to the Internet. 

 

Printing from an application on mobile device

The following steps are an example of using the Google Docs app from Android 
mobile phone.

1 Install the Cloud Print application on your mobile device. 

 

If you do not have the application, download it from the application store 

such as Android Market or App Store. 

 

2 Access the Google Docs application from your mobile device. 

3 Tap the option  button of the document that you want to print.

4 Tap the send  button.

5 Tap the Cloud Print  button.

6 Set the printing options if you want.

7 Tap Click here to Print.

Printing from the Chrome browser

The following steps are an example of using the Chrome browser.

1 Run Chrome.

2 Open the document or email that you want to print.

3 Click the wrench icon  in the browser’s top right corner.

4 Click Print. A new tab for printing appears.
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5 Select Print with Google Cloud Print.

6 Click the Print button.
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3. Special Features
This chapter explains special printing features.
• Altitude adjustment 138
• Printing features 139
 

The procedures in this chapter are mainly based on Windows 7.

 



Altitude adjustment

Print quality is affected by atmospheric pressure, which is determined by the 
height of the machine above sea level. The following information will guide you 
on how to set your machine for the best print quality.

Before you set the altitude value, determine the altitude where you are.

• Normal: 0-1,000 m(3,280 ft)

• High1: 1,000 m(3,280 ft)-2,000 m(6,561 ft)

• High2: 2,000 m(6,561 ft)-3,000m(9,842 ft) 

• High3: 3,000 m(9,842 ft)-4,000 m(13,123 ft)

• High4: 4,000 m(13,123 ft)-5,000 m(16,404 ft)

• For Windows and Mac users, you set from Samsung Easy Printer Manager 
> Advanced Setting > Device Settings. See "Using Samsung Easy Printer 
Manager" on page 162.

 

If your machine is connected to the network, you can set the altitude via 
SyncThru™ Web Service (see "Using SyncThru™ Web Service" on page 159).
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Printing features

 

• For basic printing features, refer to the Basic Guide (see "Basic printing" 
on page 35).

• This feature may not be available depending on model or optional goods 
(see "Features by model" on page 6).
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Changing the default print settings

1 Click the Windows Start menu. 

• For Windows 8, from the Charms, select Search > Settings.

2 For Windows XP/Server 2003, select Printer and Faxes. 

• For Windows Server 2008/Vista, select Control Panel > Hardware 
and Sound > Printers. 

• For Windows Server 2008 R2, select Control Panel > Hardware > 
Devices and Printers. 

• For Windows 7/8, select Control Panel > Devices and Printers. 

3 Right-click on your machine.

4 For Windows XP/Server 2003/Server 2008/Vista, select Printing 
Preferences.

For Windows 7/8 or Windows Server 2008 R2, from context menus, select 
Printing preferences.

 

If Printing preferences has a ►, you can select other printer drivers 
connected to the selected printer.

 

5 Change the settings on each tab. 

6 Click OK.

 

If you want to change the settings for each print job, change it in Printing 
Preferences. 
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Setting your machine as a default machine

1 Click the Windows Start menu.

• For Windows 8, from the Charms, select Search > Settings.

2 For Windows XP/Server 2003, select Printer and Faxes. 

• For Windows Server 2008/Vista, select Control Panel > Hardware 
and Sound > Printers. 

• For Windows Server 2008 R2, select Control Panel > Hardware > 
Devices and Printers. 

• For Windows 7/8, select Control Panel > Devices and Printers. 
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3 Select your machine.

4 Right-click your machine and select Set as Default Printer.

 

For Windows 7 or Windows Server 2008 R2, if Set as default printer has a 
►, you can select other printer drivers connected to the selected printer.
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Using advanced print features

 

XPS printer driver: used to print XPS file format. 

• See "Features by model" on page 6.

• The XPS printer driver can be installed only on Windows Vista OS or 
higher.

• For models that provide XPS driver from the Samsung website, http://
www.samsung.com  > find your product> Support or downloads.

 

Printing to a file (PRN)

You will sometimes need to save the print data as a file. 

1 Check the Print to file box in the Print window.

2 Click Print.

3 Type in the destination path and the file name, and then click OK.

For example, c:\Temp\file name.

 

If you type in only the file name, the file is automatically saved in My 
Documents, Documents and Settings, or Users. The saved folder may 
differ, depending on your operating system or the application you are 
using.
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Understanding special printer features

You can use advanced printing features when using your machine.

To take advantage of the printer features provided by your printer driver, click Properties or Preferences in the application’s Print window to change the print 
settings. The machine name that appears in the printer properties window may differ depending on the machine in use.

 

• Some menus may not appear on the display depending on options or models. If so, it is not applicable to your machine.

• Select the Help menu or click the  button from the window or press F1 on your keyboard and click on any option you want to know about (see "Using help" 
on page 38).

 

 

Item Description

Multiple Pages per 
Side

Selects the number of pages to print on a single sheet of paper. To print more than one page per sheet, the pages will be reduced in size and 
arranged in the order you specify. You can print up to 16 pages on one sheet. 
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Poster Printing
Prints a single-page document onto 4 (Poster 2x2), 9 (Poster 3x3), or 16 (Poster 4x4) sheets of paper, for the purpose of pasting the sheets 
together to form one poster-size document.

Select the Poster Overlap value. Specify Poster Overlap in millimeters or inches by selecting the radio button on the upper right of Basic tab 
to make it easier to paste the sheets together.

Booklet Printing

Prints your document on both sides of a sheet of paper and arranges the pages so that the paper can be folded in half after printing to produce 
a booklet. 

 

• This option is available only when you use the PCL/SPL printer driver. This option is not available when you use XPS driver.

• The Booklet Printing option is not available for all paper sizes. Select the available paper Size option under the Paper tab to see what 
paper sizes are available.

• If you select an unavailable paper size, this option can be automatically canceled. Select only available paper (paper without  or  
mark).

 

Item Description

8 9
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Double-sided 
Printing (Manual)

Print on both sides of a sheet of paper (duplex). Before printing, decide how you want your document oriented. 

 

• This option is available only when you use the PCL/SPL printer driver. This option is not available when you use XPS driver.

• If your machine does not have a duplex unit, you should complete the printing job manually. The machine prints every other page of 
the document first. After that, a message appears on your computer.

• Skip Blank Pages feature does not work when you select the duplex option.

 

• None: Disables this feature.

• Long Edge: This option is the conventional layout used in bookbinding.

• Short Edge: This option is the conventional layout used in calendars.

Paper Options Changes the size of a document to appear larger or smaller on the printed page by entering in a percentage by which to enlarge or decrease the 
document.

Item Description
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Watermark The watermark option allows you to print text over an existing document. For example, you use it when you want to have large gray letters 
reading “DRAFT” or “CONFIDENTIAL” printed diagonally across the first page or all pages of a document. 

Watermark

(Creating a 
watermark)

a To change the print settings from your software application, access Printing Preferences (see "Opening Printing Preferences" on page 36).

b From the Advanced tab, select Edit... from the Watermark drop-down list. 
c Enter a text message in the Watermark Message box. You can enter up to 256 characters. 

When the First Page Only box is checked, the watermark prints on the first page only.
d Select watermark options. 

You can select the font name, style, size, and shade from the Font Attributes section, as well as set the angle of the watermark from the 
Watermark Alignment and Angle section. 

e Click Add to add a new watermark to the Current Watermarks list.   
f When you finish editing, click OK or Print until you exit the Print window.

Watermark

(Editing a watermark)

a To change the print settings from your software application, access Printing Preferences (see "Opening Printing Preferences" on page 36).

b Click the Advanced tab, select Edit... from the Watermark drop-down list.
c Select the watermark you want to edit from the Current Watermarks list and change the watermark message and options. 
d Click Update to save the changes.
e Click OK or Print until you exit the Print window. 

Watermark

(Deleting a 
watermark)

a To change the print settings from your software application, access Printing Preferences.

b Click the Advanced tab, select Edit... from the Watermark drop-down list.
c Select the watermark you want to delete from the Current Watermarks list and click Delete. 
d Click OK or Print until you exit the Print window.

Item Description
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Overlaya

This option is available only when you use the PCL/SPL printer driver. This option is not available when you use XPS driver

An overlay is text and/or images stored in the computer hard disk drive (HDD) as a special file format that can be printed on any document. 
Overlays are often used to take the place of letterhead paper. Rather than using preprinted letterhead, you can create an overlay containing 
exactly the same information that is currently on your letterhead. To print a letter with your company’s letterhead, you do not need to load 
preprinted letterhead paper in the machine: just print the letterhead overlay on your document.

To use a page overlay, you must create a new page overlay containing your logo or image.

 

• The overlay document size must be the same as the document you print with the overlay. Do not create an overlay with a watermark.

• The resolution of the overlay document must be the same as that of the document you will print with the overlay.

 

Overlaya

(Creating a new page 
overlay)

a Create or open a document containing text or an image for use in a new page overlay. Position the items exactly as you wish them to appear 
when printed as an overlay.

b To save the document as an overlay, access Printing Preferences.
c Click the Advanced tab, and select Create from the Overlay drop-down list.
d In the Save As window, type a name up to eight characters in the File name box. Select the destination path, if necessary (The default is 

C:\Formover).
e Click Save.

f Click OK or Print until you exit the Print window.

When a confirming message window appears, click Yes.
g The file is not printed. Instead, it is stored on your computer hard disk drive.

Item Description
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Overlaya

(Using a page overlay)

a Create or open the document you want to print.
b To change the print settings from your software application, access Printing Preferences.
c Click the Advanced tab. 
d Select the Print Overlay from the Overlay drop-down list. 
e If the overlay file you want does not appear in the Overlay File 1 or Overlay File 2 drop-down list, select Load from the Overlay List. Select 

the overlay file you want to use. 
If you have stored the overlay file you want to use in an external source, you can also load the file when you access the Load window. 
After you select the file, click Open. The file appears in the Overlay List box and is available for printing. Select the overlay from the Overlay 
List box. 

f If necessary, check Confirm Page Overlay When Printing box. If this box is checked, a message window appears each time you submit a 
document for printing, asking you to confirm your wish to print an overlay on your document. 
If this box is not checked and an overlay has been selected, the overlay automatically prints with your document. 

g Click OK or Print until you exit the Print window. 
The selected overlay prints on your document. 

Overlaya

(Deleting a page 
overlay)

a In the Printing Preferences window, click the Advanced tab. 
b Select Edit in the Text drop down list. 
c Select the overlay you want to delete from the Overlay List box. 
d Click Delete. 
e When a confirming message window appears, click Yes.
f Click OK or Print until you exit the Print window. You can delete page overlays that you no longer use.

a. This option is not available when you use XPS driver.

Item Description
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4 

Mac printing

 

Some features may not be available depending on models or options. It 
means that the features are not supported.

 

Printing a document

When you print with a Mac, you need to check the printer driver settings in each 
application you use. Follow the steps below to print from a Mac:

1 Open the document to print.

2 Open the File menu and click Page Setup (Document Setup in some 
applications).

3 Choose your paper size, orientation, scaling, other options, and make 
sure that your machine is selected. Click OK.

4 Open the File menu and click Print. 

5 Choose the number of copies and indicate which pages to print. 

6 Click Print.

Changing printer settings

You can use advanced printing features when using your machine.

Open an application and select Print from the File menu. The machine name, 
which appears in the printer properties window, may differ depending on the 
machine in use. Except for the name, the composition of the printer properties 
window is similar to the following.

Printing multiple pages on one sheet 

You can print more than one page on a single sheet of paper. This feature 
provides a cost-effective way to print draft copies.

1 Open an application, and select Print from the File menu.

2 Select Layout from the drop-down list under Orientation. In the Pages 
per Sheet drop-down list, select the number of pages you want to print 
on one sheet of paper.

3 Select the other options to use.

4 Click Print. 

The machine prints the selected number of pages to print on one sheet 
of paper.
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Printing on both sides of the paper

 

Some features may not be available depending on models or options. It 
means that the features are not supported (see "Variety feature" on page 8).

 

Before printing in the duplex mode, decide on which edge you will be binding 
your finished document. The binding options are, as follows:

• Long-Edge Binding: This option is the conventional layout used in book 
binding.

• Short-Edge Binding: This option is the type often used with calendars.

1 From your Mac application, select Print from the File menu.

2 Select Layout from the drop-down list under Orientation. 

3 Select a binding orientation from the Two-Sided option.

4 Select the other options to use.

5 Click Print and the machine prints on both sides of the paper.

 

If you print more than 2 copies, the first copy and the second copy might 
print on the same sheet of paper. Avoid printing on both sides of paper 
when you are printing more than 1 copy.

 

Using help

Click the question mark on the bottom-left corner of the window and click on 
the topic you want to know about. A pop-up window appears with information 
about that option's feature, which is provided from the driver. 
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5 

Linux printing

 

Some features may not be available depending on models or options. It 
means that the features are not supported.

 

Printing from applications

There are a lot of Linux applications that allow you to print using Common UNIX 
Printing System (CUPS). You can print on your machine from any such 
application.

1 Open the document to print.

2 Open the File menu and click Page Setup (Print Setup for some

applications).

3  Choose your paper size, orientation, and make

sure that your machine is selected. Click Apply.

4  Open the File menu and click Print.

5  Select your machine to print.

6 Choose the number of copies and indicate which pages to print.

7 Change other printing options in each tab, if necessary.

8 Click Print.

 

Automatic/manual duplex printing may not be available depending on 
models. You can alternatively use the lpr printing system or other 
applications for odd-even printing (see "Features by model" on page 6).

 

Printing files

You can print text, image, pdf files on your machine using the standard

CUPS directly from the command line interface. The CUPS lp or lpr utility allows 
you to do that. You can print these files by using below command format.

"lp -d <printer name> -o <option> <file name>"

Please refer to lp or lpr man page on your system for more details.
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Configuring Printer Properties

You can change the default printing options or connection type with Printing 
utility supplied by o/s.

1 Launch Printing utility(Go to System > Administration > Printing 
menu or execute "system-config-printer" command in Terminal 
program).

2 Select your printer and double-click it.

3 Change default printing options or connection type.

4 Click Apply button.
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4. Useful Management 
Tools

This chapter introduces management tools provided to help you make full use of your machine. 
• Accessing management tools 152
• Easy Capture Manager 153
• Samsung Easy Color Manager 154
• Easy Eco Driver 155
• Using Samsung Printer Center 156
• Using SyncThru™ Web Service 159
• Using Samsung Easy Printer Manager 162 
• Using Samsung Printer Status 164
• Using Samsung Printer Experience 166



Accessing management tools

Samsung provides a variety of management tools for Samsung printers. 

1 Make sure that the machine is connected to your computer and powered on.

2 From the Start menu, select Programs or All Programs.

• For Windows 8, from the Charms, select Search > Apps.

3 Find Samsung Printers.

4 Under Samsung Printers, you can see installed management tools.

5 Click the management tool you want to use.

 

• After installing the driver, for some management tools, you can access them directly from the Start menu > Programs or All Programs.

• For Windows 8, after installing the driver, for some management tools, you can access them directly from the Start screen by clicking on the corresponding tile.
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Easy Capture Manager

 

• This feature may not be available depending on model or optional goods (see "Software" on page 7).

• Available for Windows OS users only (see "Software" on page 7).

 

Capture your screen and launch Easy Capture Manager by simply pressing the Print Screen key on the keyboard. Now you can easily print your captured screen as 
captured or edited.
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Samsung Easy Color Manager

Samsung Easy Color Manager helps users do fine adjustments with 6 color tones and other properties, such as brightness, contrast, and saturation. Color tone 
changes can be saved as a profile and can be used from the driver or from inside of the machine.

 

• This feature may not be available depending on model or optional goods (see "Software" on page 7).

• Available for Windows and Mac OS users only (see "Software" on page 7).

 

Helps Samsung color laser printer users to adjust color as they like.

Download the software from the Samsung website then unpack and install it: (http://www.samsung.com > find your product > Support or Downloads).
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Easy Eco Driver

 

• Available for Windows OS users only (see "Software" on page 7).

• To use the Easy Eco Driver features, the Eco Driver Pack must be installed.

 

With the Easy Eco Driver, you can apply Eco features to save paper and toner before printing. 

Easy Eco Driver also allows you simple editing such as removing images and texts, and more. You can save frequently used settings as a favorite.

How to use: 

1 Open a document to print.

2 Open printing preference window (see "Opening Printing Preferences" on page 36).

3 From the Favorites tab, select Eco Printing Preview.

4 Click OK > Print in the window. A preview window appears.

5 Select the options you want to apply to the document.

You can see the preview of the applied features.

6 Click Print.

 

• If you want to run Easy Eco Driver every time you print, check Start Easy Eco Driver before printing job checkbox in the Basic tab of the printing preference 
window.

• To use this feature on Stylish User Interface, click Samsung Printer Center > Device Options and then select Stylish User Interface (see "Using Samsung Printer 
Center" on page 156).
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Using Samsung Printer Center

 

• Available for Windows users only.

 

The Samsung Printer Center allows you to manage all the printer drivers 
installed on your computer from a single integrated application. You can use the 
Samsung Printer Center to add and remove printer drivers, check the status of 
printers, update printer software, and configure printer driver settings.

1 

Understanding Samsung Printer Center

To open the program: 

For Windows,

Select Start > Programs or All Programs > Samsung Printers > Samsung 
Printer Center.

Printers tab

 

The screenshot may differ depending on operating system you are using.

 

1
Printer list Displays the printer drivers installed on your computer. To add a 

printer driver to the list, click the  button.
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Scanner & Fax Tab

 

• The screenshot may differ depending on operating system you are using.

• Available for multifunction products only.

 

2

Quick links Displays links to various printer driver management functions. 
The quick links in the Printers tab link to the following functions:

• Settings: Allows you to configure the settings for individual 
printer driver.

- Set as default printer: Sets the selected printer driver as 
the default printer. If the selected printer driver is already 
set as the default printer, then this option is not activated.

- Printing preferences: Allows you to configure the default 
print settings.

- Device options: Allows you to configure advanced 
options, such as the settings for optional devices and 
additional features.

 

The option allows you to modify the Printer Status 
and Stylish User Interface settings.

 

- Change device: Allows you to change the device into 
another device.

- Properties: Allows you to configure the printer driver 
properties, such as the name of the printer driver and its 
location, or add comments about the printer driver .

• Actions: Allows you to use the scan feature (this option is 
enabled only if the selected device supports the scan feature).

• Management: Allows you to manage the devices registered 
in the program.
- Add a new printer / Remove printer: Adds a new device 

or removes an existing device.
- Diagnose printer: Diagnoses problems in the selected 

device and suggests solutions.
- Update software: Downloads and applies the applicable 

software updates.

3
Printer 
information

Provides general information about the selected device, such as 
its model, IP address, port number, and status.

1

Printer list Displays the fax and scanner driver installed on your 
computer. To add a fax or scanner driver to the list, click the 

(Add Fax) or (Add Scanner) button.

1 2

3
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2

Quick links Displays links to the functions available for managing fax or 
scanner drivers. The quick links in the Scanner & Fax tab offer 
the following features:

 

To use this feature, the scanner driver and fax driver 
must be installed on the computer.

 

• Settings: Allows you to configure the settings for fax or 
scanner dirvers.

- Address Book (fax only): Opens the Address Book.

- Fax Transmission History (fax only): Opens the fax 
transmission history.

- Fax preferences (fax only): Allows you to configure the 
default fax settings.

- Change device: Allows you to change the devices into 
another device.

- Properties: Allows you to configure the properties of a 
device, such as location and add comments about the 
device.

• Actions: Allows you to use the scan feature.

• Management: Allows you to manage the devices 
registered in the program.

- Remove fax or Remove scan: Removes the selected fax 
or scan driver.

- Update software: Downloads and applies the 
applicable software updates.

3
Printer 
information

Provides general information about the selected device, such 
as the model, IP address, port number, and machine status.
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Using SyncThru™ Web Service

 

• Internet Explorer 6.0 or higher is the minimum requirement for 
SyncThru™ Web Service.

• SyncThru™ Web Service explanation in this user’s guide may differ from 
your machine depending on its options or models.

• Network model only.

 

2 

Accessing SyncThru™ Web Service

1 Access a web browser, such as Internet Explorer, from Windows.

Enter the machine IP address of your printer (http://xxx.xxx.xxx.xxx) in 
the address field and press the Enter key or click Go.

2 Your machine’s embedded website opens.

Logging into SyncThru™ Web Service

Before configuring options in SyncThru™ Web Service, you need to log-in as an 
administrator. You can still use SyncThru™ Web Service without logging in but 
you won’t have access to Settings tab and Security tab. 

1 Click Login on the upper right of the SyncThru™ Web Service website.

2 If it’s your first time logging into SyncThru™ Web Service you need to 
log-in as an administrator. Type in the below default ID and password. 
We recommend you to change the default password for security 
reasons.

• ID: admin 

• Password: sec00000

3 

SyncThru™ Web Service overview

 

Some tabs may not appear depending on your model.
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Information tab

This tab gives you general information about your machine. You can check 
things, such as remaining amount of toner. You can also print reports, such as an 
error report.

• Active Alerts: Shows the alerts that have occurred in the machine and their 
severity.

• Supplies: Shows how many pages are printed and amount of toner left in 
the cartridge.

• Usage Counters: Shows the usage count by print types: simplex and 
duplex.

• Current Settings: Shows the machine’s and network’s information. 

• Print information: Prints reports such as system related reports and font 
reports.

Settings tab

This tab allows you to set configurations provided by your machine and 
network. You need to log-in as an administrator to view this tab. 

• Machine Settings tab: Sets options provided by your machine. 

• Network Settings tab: Shows options for the network environment. Sets 
options such as TCP/IP and network protocols. 

Security tab

This tab allows you to set system and network security information. You need to 
log-in as an administrator to view this tab.

• System Security: Sets the system administrator’s information and also 
enables or disables machine features.

• Network Security: Sets settings for IPv4/IPv6 filtering.

Maintenance tab

This tab allows you to maintain your machine by upgrading firmware and 
setting contact information for sending emails. You can also connect to 
Samsung website or download drivers by selecting the Link menu.

• Firmware Upgrade: Upgrade your machine’s firmware.

• Contact Information: Shows the contact information.

• Link: Shows links to useful sites where you can download or check 
information.

4 

Setting the system administrator’s information

This setting is necessary for using the e-mail notification option.
1604.  Useful Management Tools



Using SyncThru™ Web Service

1 Start a web browser, such as Internet Explorer, from Windows.

Enter the machine IP address (http://xxx.xxx.xxx.xxx) in the address field 
and press the Enter key or click Go.

2 Your machine’s embedded website opens.

3 From the Security tab, select System Security > System Administrator

4 Enter the name of the administrator, phone number, location, and email 
address. 

5 Click Apply. 
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Using Samsung Easy Printer Manager 

 

• Available for Windows and Mac OS users only.

• For Windows, Internet Explorer 6.0 or higher is the minimum 
requirement for Samsung Easy Printer Manager.

 

Samsung Easy Printer Manager is an application that combines Samsung 
machine settings into one location. Samsung Easy Printer Manager combines 
device settings as well as printing environments, settings/actions and 
launching. All of these features provide a gateway to conveniently use your 
Samsung machine. Samsung Easy Printer Manager provides two different user 
interfaces for the user to choose from: the basic user interface and the advanced 
user interface. Switching between the two interfaces is easy: just click a button.

5 

Understanding Samsung Easy Printer Manager

To open the program: 

For Windows,

Select Start > Programs or All Programs > Samsung Printers > Samsung 
Easy Printer Manager .

For Mac,

Open the Applications folder > Samsung folder > Samsung Easy Printer 
Manager.

The Samsung Easy Printer Manager interface is comprised of various basic 
sections as described in the table that follows:

 

The screenshot may differ depending on operating system you are using.

 

1
Printer list The Printer list displays printers installed on your computer 

and network printers added by network discovery (Windows 
only).

1

5

6

4

32

7
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Select the Help menu or click the  button from the window and click on 

any option you want to know about.

 

2 Advanced 
Setting

The advanced user interface is intended to be used by the person 
responsible for managing the network and machines.

 

Some menus may not appear in the display depending 
on options or models. If so, it is not applicable to your 
machine.

 

• Device Settings: You can configure various machine settings 
such as machine setup, paper, layout, emulation, network, and 
print information. 

 

If you connect your machine to a network, the SyncThru™ 
Web Service icon is enabled.

 

• Scan to PC Settings: This menu includes settings to create or 
delete scan to PC profiles. 

- Scan Activation: Determines whether or not scanning is 
enabled on the device.

- Basic tab:  Contains settings related general scan and 
device settings.

• Alert Settings (Windows only): This menu includes settings 
related to error alerting. 

- Printer Alert: Provides settings related to when alerts will 
be received.

- Email Alert: Provides options relating to receiving alerts 
via email.

- Alert History:  Provides a history of device and toner 
related alerts.

3
Application 
information

Includes links for changing to the refresh, preference setting, 
help, and about.

4

Printer 
information

This area gives you general information about your machine. You 
can check information, such as the machine’s model name, IP 
address (or Port name), and machine status.

 

This button opens the Troubleshooting Guide when an 
error occurs. You can directly open the troubleshooting 
section in the user’s guide. 

 

5

Quick links Displays Quick links to machine specific functions. This section 
also includes links to applications in the advanced settings.

 

If you connect your machine to a network, the SyncThru™ 
Web Service icon is enabled.

 

6
Contents 
area

Displays information about the selected machine, remaining 
toner level, and paper. The information will vary based on the 
machine selected. Some machines do not have this feature.

7
Order 
supplies

Click on the Order button from the supply ordering window. You 
can order replacement toner cartridge(s) from online.
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The Samsung Printer Status is a program that monitors and informs you of the 
machine status. 

 

• The Samsung Printer Status window and its contents shown in this user’s 
guide may differ depending on the machine or operating system in use.

• Check the operating system(s) that are compatible with your machine 
(see "System requirements" on page 71).

• Available for Windows OS users only.

 

6 

Samsung Printer Status overview

If an error occurs while operating, you can check the error from the Samsung 
Printer Status. Samsung Printer Status is installed automatically when you install 
the machine software. 

You can also launch Samsung Printer Status manually. Go to the Printing 
Preferences, click the Basic tab > Printer Status button.

These icons appear on the Windows task bar:

Icon Mean Description

Normal The machine is in ready mode and experiencing no 
errors or warnings.

Warning The machine is in a state where an error might 
occur in the future. For example, it might be in 
toner low status, which may lead to toner empty 
status.

Error The machine has at least one error.

1

3

2

7

4 5 6
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1

Device 
Information

You can see the device status , current printer model 
name, connected port name in this area.

2

User’s Guide You can view the online User’s Guide.

 

This button opens the Troubleshooting Guide 
when an error occurs. You can directly open the 
troubleshooting section in the user’s guide. 

 

3

Supplies 
Information

You can view the percentage of toner remaining in 
each toner cartridge. The machine and the number of 
toner cartridge(s) shown in the above window may 
differ depending on the machine in use. Some 
machines do not have this feature.

4

Option
You can set printing job alert related settings. 

5

Order Supplies You can order replacement toner cartridge(s) from 
online.

6

Cancel Print 

or 

Close

• Cancel Print : If print job is waiting in the print 
queue or printer, cancel all user's print jobs in the 
print queue or the printer.

• Close : Depending on the status of the machine or 
the supported functions, the Close  button may 
appear to close the status window.

7 Toner/Paper 
Information

This button areas for paper and toner info will be 
available based on the device.
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Samsung Printer Experience is a Samsung application that combines 
Samsung machine settings and machine management into one location. You 
can set device settings, order supplies, open troubleshooting guides, visit 
Samsung’s web site, and check connected machine information. This 
application will be automatically downloaded from the Windows Store if the 
machine is connected to a computer with an Internet connection. 

7 

Understanding the Samsung Printer Experience

To open the application, 

From the Start screen, select the Samsung Printer Experience ( ) tile. 

The Samsung Printer Experience interface comprises various useful features as 
described in the following table:

 

The screenshot may differ depending on the model you are using.

 

1

Printer 
Information

This area gives you general information about your 
machine. You can check information, such as the 
machine’s status, location, IP address, and remaining 
toner level.

1
2 6

3

4

5

1664.  Useful Management Tools



Using Samsung Printer Experience

8 

Adding/Deleting Printers

If you do not have any printer added to the Samsung Printer Experience, or if 
you want to add/delete a printer, follow the instructions below. 

 

You can only add/delete network connected printers.

 

Adding a printer

1 From the Charms, select Settings.

Or, right-click the Samsung Printer Experience page and select 
Settings.

2 Select Add Printer

3 Select the printer you want to add.

You can see the added printer.

 

If you see  mark, you can also click  mark to add printers.

 

2 User’s Guide You can view the online User’s Guide. You need to be 
connected to the Internet to use this feature.

 

This button opens the Troubleshooting Guide 
when an error occurs. You can directly open the 
troubleshooting section in the user’s guide. 

 

3
Order Supplies Click on this button to order replacement toner 

cartridges online. You need to be connected to the 
Internet to use this feature. 

4
Visit Samsung Links to Samsung printer website. You need to be 

connected to the Internet to use this feature.

5

Printer Settings You can configure various machine settings such as 
machine setup, paper, layout, emulation, networking, 
and print information through SyncThru™ Web Service. 
Your machine needs to be connected to a network. This 
button will be disabled if your machine is connected via 
USB cable.

6

Device List & 
Latest Scanned 
Image

The scan list displays devices that supports Samsung 
Printer Experience. Under the device, you can see the 
latest scanned images. Your machine needs to be 
connected to a network to scan from here. 

This section is for the users with multi-functional printers.
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Deleting a printer

1 From the Charms, select Settings.

Or, right-click the Samsung Printer Experience page and select 
Settings.

2 Select Remove Printer

3 Select the printer you want to delete.

4 Click Yes.

You can see that the deleted printer is removed from the screen.

9 

Printing from Windows 8

This section explains common printing tasks from the Start screen.

Basic printing

1 Open the document to print.

2 From the Charms, select Devices.

3 Select your printer from the list

4 Select the printer settings, such as the number of copies and orientation.

5 Click the Print button to start the print job.

Cancelling a print job

If the printing job is waiting in the print queue or print spooler, cancel the job as 
follows:

• You can access this window by simply double-clicking the machine icon 

( ) in the Windows task bar. 

• You can also cancel the current job by pressing (Cancel or Stop/Clear) 

button on the control panel.
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Opening more settings

 

The screen may appear somewhat different depending on the model or 
options.

 

You can set up more printing parameters.

1 Open the document you want to print.

2 From the Charms, select Devices.

3 Select your printer from the list

4 Click More settings.

Basic tab

Basic

This option allows you to choose the basic printing settings such as copies, 
orientation, and document type.

Eco settings

This option allows you to choose multiple pages per side to save media.
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Advanced tab

Paper settings

This option allows you to set the basic paper handling specifications.

Layout settings

This option allows you to set the various ways to layout your documents.

Security tab
 

Some features may not be available depending on the model or options. If 
this tab is not shown or disabled, it means that these features are not 
supported.

 

Job Accounting

This option allows you to print with the given permission.

Confidential Printing

This option is used for printing confidential documents. You need to enter a 
password to print using it.
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Using the sharing feature

 Samsung Printer Experience allows you to print from other applications 
installed on the computer using the sharing feature. 

 

 This feature is only available for printing jpeg, bmp, tiff, gif, and png file 
formats.

 

1 Select the content you want to print from other application.

2 From the Charms, select Share > Samsung Printer Experience .

3 Select the printer settings, such as the number of copies and orientation.

4 Click the Print button to start the print job.
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5. Troubleshooting
This chapter gives helpful information for what to do if you encounter an error.
• Paper feeding problems 173
• Power and cable connecting problems 174
• Printing problems 175
• Printing quality problems 179
• Operating system problems 187



Paper feeding problems
Condition Suggested solutions

Paper jams during printing. Clear the paper jam.

Paper sticks together. • Check the maximum paper capacity of the tray.

• Make sure that you are using the correct type of paper.

• Remove paper from the tray and flex or fan the paper.

• Humid conditions may cause some paper to stick together.

Multiple sheets of paper do not feed. Different types of paper may be stacked in the tray. Load paper of only one type, size, and weight.

Paper does not feed into the machine. • Remove any obstructions from inside the machine.

• Paper has not been loaded correctly. Remove paper from the tray and reload it correctly.

• There is too much paper in the tray. Remove excess paper from the tray.

• The paper is too thick. Use only paper that meets the specifications required by the machine.

The paper keeps jamming. • There is too much paper in the tray. Remove excess paper from the tray. If you are printing on special materials, feed 
manually in the tray.

• An incorrect type of paper is being used. Use only paper that meets the specifications required by the machine.

• There may be debris inside the machine. Open the top cover and remove any debris.
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Power and cable connecting problems

Reboot the power. If the problem persists, please call for service.

Condition Suggested solutions

The machine is not receiving power, 

or the connection cable between the 
computer and the machine is not 
connected properly.

1 Connect the machine to the electricity supply first. 

2 Check the USB cable or network cable in the machine’s rear.

3 Disconnect the USB cable or network cable in the machine’s rear and then, reconnect it.

1

2
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Printing problems
Condition Possible cause Suggested solutions

The machine does not 
print.

The machine is not receiving power. Check the power cord connections. Check the power switch and the power source.

The machine is not selected as the default 
machine.

Select your machine as your default machine in Windows.

Check the machine for the following:

• The top cover is not closed. Close the top cover.

• Paper is jammed. Clear the paper jam (see "Clearing paper jams" on page 59).

• No paper is loaded. Load paper (see"Loading paper in the tray" on page 28).

• The toner cartridge is not installed. Install the toner cartridge (see "Replacing the toner cartridge" on page 48).

• Make sure the protect cover and sheets are removed from the toner cartridge (see "Replacing the toner cartridge" on page 48).

If a system error occurs, contact your service representative.

The connection cable between the computer and 
the machine is not connected properly.

Disconnect the machine cable and reconnect it (see "Rear view" on page 19).

The connection cable between the computer and 
the machine is defective.

If possible, attach the cable to another computer that is working properly and print a job. 
You can also try using a different machine cable.

The port setting is incorrect. Check the Windows printer settings to make sure that the print job is sent to the correct 
port. If the computer has more than one port, make sure that the machine is attached to 
the correct one.

The machine may be configured incorrectly. Check the Printing Preferences to ensure that all of the print settings are correct.
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Printing problems
The machine does not 
print.

The printer driver may be incorrectly installed. Uninstall and reinstall the machine’s driver.

The machine is malfunctioning. Check the display message on the control panel to see if the machine is indicating a 
system error. Contact a service representative.

The document size is so big that the hard disk 
space of the computer is insufficient to access the 
print job.

Get more hard disk space and print the document again.

The output tray is full. Once the paper is removed from the output tray, the machine resumes printing.

The machine selects print 
materials from the wrong 
paper source.

The paper option that was selected in the 
Printing Preferences may be incorrect.

For many software applications, the paper source selection is found under the Paper tab 
within the Printing Preferences (see "Opening Printing Preferences" on page 36). 
Select the correct paper source. See the printer driver help screen (see "Using help" on 
page 38).

A print job is extremely 
slow.

The job may be very complex. Reduce the complexity of the page or try adjusting the print quality settings.

Half the page is blank. The page orientation setting may be incorrect. Change the page orientation in your application (see "Opening Printing Preferences" on 
page 36). See the printer driver help screen (see "Using help" on page 38).

The paper size and the paper size settings do not 
match.

Ensure that the paper size in the printer driver settings matches the paper in the tray.

Or, ensure that the paper size in the printer driver settings matches the paper selection 
in the software application settings you use (see "Opening Printing Preferences" on 
page 36).

Condition Possible cause Suggested solutions
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Printing problems
The machine prints, but 
the text is wrong, 
garbled, or incomplete.

The machine cable is loose or defective. Disconnect the machine cable and reconnect. Try a print job that you have already 
printed successfully. If possible, attach the cable and the machine to another computer 
that you know works and try a print job. Finally, try a new machine cable.

The wrong printer driver was selected. Check the application's printer selection menu to ensure that your machine is selected.

The software application is malfunctioning. Try printing a job from another application.

The operating system is malfunctioning. Exit Windows and reboot the computer. Turn the machine off and back on again.

Pages print, but they are 
blank.

The toner cartridge is defective or out of toner. Redistribute the toner, if necessary. 

If necessary, replace the toner cartridge.

• See "Redistributing toner" on page 46.

• See "Replacing the toner cartridge" on page 48.

The file may have blank pages. Check the file to ensure that it does not contain blank pages.

Some parts, such as the controller or the board, 
may be defective.

Contact a service representative.

The machine does not 
print PDF files correctly. 
Some parts of graphics, 
text, or illustrations are 
missing.

Incompatibility between the PDF file and the 
Acrobat products.

Printing the PDF file as an image may enable the file to print. Turn on Print As Image 
from the Acrobat printing options. 

 

It will take longer to print when you print a PDF file as an image.

 

The print quality of 
photos is not good. 
Images are not clear.

The resolution of the photo is very low. Reduce the photo size. If you increase the photo size in the software application, the 
resolution will be reduced. 

Condition Possible cause Suggested solutions
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Printing problems
Before printing, the 
machine emits vapor near 
the output tray.

Using damp/wet paper can cause vapor [white 
smoke] during printing.

This is not a problem, just keep printing.  If you are bothered by the smoke [vapor], then 
replace the paper with fresh paper from an unopened ream.

The machine does not 
print special-sized paper, 
such as billing paper.

Paper size and paper size setting do not match. Set the correct paper size in the Custom in Paper tab in Printing Preferences (see 
"Opening Printing Preferences" on page 36).

The printed billing paper 
is curled.

The paper type setting does not match. Change the printer option and try again. Go to Printing Preferences, click Paper tab, 
and set type to Thick (see "Opening Printing Preferences" on page 36).

Condition Possible cause Suggested solutions
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Printing quality problems

If the inside of the machine is dirty or paper has been loaded improperly, there might be a reduction in print quality. See the table below to clear the problem. 

 

Condition Suggested Solutions

Light or faded print • If a vertical white streak or faded area appears on the page, the toner supply is low. Install a new toner cartridge (see "Replacing the 
toner cartridge" on page 48).

• If a vertical white streak or faded area still appears on the page even though the machine has enough toner supply, open and close 
the front door 3 ~ 4 times (see "Machine overview" on page 17).

• The paper may not meet paper specifications; for example, the paper may be too moist or rough.

• If the entire page is light, the print resolution setting is too low or the toner save mode is on. Adjust the print resolution and turn 
the toner save mode off. See the help screen of the printer driver.

• A combination of faded or smeared defects may indicate that the toner cartridge needs cleaning. Clean the inside of your machine 
(see "Cleaning the machine" on page 54).

• The surface of the LSU part inside the machine may be dirty. Clean the inside of your machine (see "Cleaning the machine" on page 
54). If these steps do not correct the problem, contact a service representative.

The top half of the paper is 
printed lighter than the rest of 
the paper

The toner might not adhere properly to this type of paper.

• Change the printer option and try again. Go to Printing Preferences, click the Paper tab, and set the paper type to Recycled (see 
"Opening Printing Preferences" on page 36).
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Printing quality problems
Toner specks • The paper may not meet specifications; for example, the paper may be too moist or rough.

• The transfer roller may be dirty. Clean the inside of your machine (see "Cleaning the machine" on page 54).

• The paper path may need cleaning. Contact a service representative (see "Cleaning the machine" on page 54).

Dropouts If faded areas, generally rounded, occur randomly on the page:

• A single sheet of paper may be defective. Try reprinting the job.

• The moisture content of the paper is uneven or the paper has moist spots on its surface. Try a different brand of paper.

• The paper lot is bad. The manufacturing processes can cause some areas to reject toner. Try a different kind or brand of paper.

• Change the printer option and try again. Go to Printing Preferences, click the Paper tab, and set type to Thick or Thicker (see 
"Opening Printing Preferences" on page 36).

If these steps do not correct the problem, contact a service representative.

White Spots If white spots appear on the page:

• The paper is too rough and a lot of dirt from paper falls to the inner components within the machine, so the transfer roller may be 
dirty. Clean the inside of your machine (see "Cleaning the machine" on page 54).

• The paper path may need cleaning. Clean the inside of your machine (see "Cleaning the machine" on page 54).

If these steps do not correct the problem, contact a service representative.

Condition Suggested Solutions
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1805.  Troubleshooting



Printing quality problems
Vertical lines If black vertical streaks appear on the page:

• The surface (drum part) of the imaging unit inside the machine has probably been scratched. Remove the toner cartridge and install 
a new one (see "Replacing the imaging unit" on page 52).

If white vertical streaks appear on the page:

• The surface of the LSU part inside the machine may be dirty. Clean the inside of your machine (see "Cleaning the machine" on page 
54). If these steps do not correct the problem, contact a service representative.

Black background If the amount of background shading becomes unacceptable:

• Change to a lighter weight paper.

• Check the environmental conditions: very dry conditions or a high level of humidity (higher than 80% RH) can increase the amount 
of background shading.

• Remove the old imaging unit and install a new one (see "Replacing the imaging unit" on page 52).

• Thoroughly redistribute the toner (see "Redistributing toner" on page 46).

Toner smear • Clean the inside of the machine (see "Replacing the toner cartridge" on page 48).

• Check the paper type and quality.

• Remove the old imaging unit and install a new one (see "Replacing the imaging unit" on page 52).

Condition Suggested Solutions
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Printing quality problems
Vertical repetitive defects If marks repeatedly appear on the printed side of the page at even intervals:

• The imaging unit may be damaged. If you still have the same problem, remove the imaging unit and, install a new one (see 
"Replacing the imaging unit" on page 52).

• Parts of the machine may have toner on them. If the defects occur on the back of the page, the problem will likely correct itself after 
a few more pages.

• The fusing assembly may be damaged. Contact a service representative.

Background scatter Background scatter results from bits of toner randomly distributed on the printed page. 

• The paper may be too damp. Try printing with a different batch of paper. Do not open packages of paper until necessary so that 
the paper does not absorb too much moisture.

• If background scatter covers the entire surface area of a printed page, adjust the print resolution through your software application 
or in Printing Preferences (see "Opening Printing Preferences" on page 36). Ensure the correct paper type is selected. For example: 
If Thicker Paper is selected, but Plain Paper actually used, an overcharging can occur causing this copy quality problem.

• If you are using a new toner cartridge, redistribute the toner first (see "Redistributing toner" on page 46). 

Toner particles are around bold 
characters or pictures

The toner might not adhere properly to this type of paper.

• Change the printer option and try again. Go to Printing Preferences, click the Paper tab, and set the paper type to Recycled (see 
"Opening Printing Preferences" on page 36).

• Ensure the correct paper type is selected. For example: If Thicker Paper is selected, but Plain Paper actually used, an overcharging 
can occur causing this copy quality problem.

Condition Suggested Solutions

A
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Printing quality problems
Misformed characters • If characters are improperly formed and producing hollow images, the paper stock may be too slick. Try different paper.

Page skew • Ensure that the paper is loaded properly.

• Check the paper type and quality.

• Ensure that the guides are not too tight or too loose against the paper stack.

Curl or wave • Ensure that the paper is loaded properly.

• Check the paper type and quality. Both high temperature and humidity can cause paper curl.

• Turn the stack of paper over in the tray. Also try rotating the paper 180° in the tray.

Condition Suggested Solutions
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Printing quality problems
Wrinkles or creases • Ensure that the paper is loaded properly.

• Check the paper type and quality.

• Turn the stack of paper over in the tray. Also try rotating the paper 180° in the tray.

Back of printouts are dirty • Check for leaking toner. Clean the inside of the machine (see "Cleaning the machine" on page 54).

Solid color or black pages • The imaging unit may not be installed properly. Remove the imaging unit and reinsert it.

• The imaging unit may be defective. Remove the imaging unit and install a new one (see "Replacing the imaging unit" on page 52).

• The machine may require repairing. Contact a service representative.

Condition Suggested Solutions

A
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Printing quality problems
Loose toner • Clean the inside of the machine (see "Cleaning the machine" on page 54).

• Check the paper type and quality.

• Remove the imaging unit and then, install a new one (see "Replacing the imaging unit" on page 52).

If the problem persists, the machine may require repair. Contact a service representative.

Character voids Character voids are white areas within parts of characters that should be solid black:

• You may be printing on the wrong surface of the paper. Remove the paper and turn it around. 

• The paper may not meet paper specifications.

Horizontal stripes If horizontally aligned black streaks or smears appear:

• The imaging unit may be installed improperly. Remove the imaging unit and reinsert it.

• The imaging unit may be defective. Remove the imaging unit and install a new one (see "Replacing the imaging unit" on page 52).

If the problem persists, the machine may require repairing. Contact a service representative.

Condition Suggested Solutions

A
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Printing quality problems
 

Curl If the printed paper is curled or paper does not feed into the machine:

• Turn the stack of paper over in the tray. Also try rotating the paper 180° in the tray. 

• Change the printer’s paper option and try again. Go to Printing Preferences, click the Paper tab, and set type to Thin (see 
"Opening Printing Preferences" on page 36).

• An unknown image 
repetitively appears on a few 
sheets

• Loose toner

• Light print or contamination 
occurs

Your machine is probably being used at an altitude of 1,000 m (3,281 ft) or above.

The high altitude may affect the print quality, such as loose toner or light imaging. Change the altitude setting for your machine (See 
"Altitude adjustment" on page 138).

Condition Suggested Solutions
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Operating system problems

1 

Common Windows problems

 

Refer to the Microsoft Windows User’s Guide that came with your computer for further information on Windows error messages.

 

Condition Suggested solutions

“File in Use” message appears 
during installation.

Exit all software applications. Remove all software from the startup group, then restart Windows. Reinstall the printer driver.

“General Protection Fault”, 
“Exception OE”, “Spool 32”, or 
“Illegal Operation” messages 
appear.

Close all other applications, reboot Windows and try printing again.

“Fail To Print”, “A printer 
timeout error occurred” 
message appear.

These messages may appear during printing. Just keep waiting until the machine finishes printing. If the message appears in ready 
mode or after printing has completed, check the connection and/or whether an error has occurred.

Samsung Printer Experience is 
not shown when you click more 
settings.

Samsung Printer Experience is not installed. Download the app. from the Windows Store and install it.

Machine information is not 
displayed when you click the 
device in the Devices and 
Printers.

Check the Printer properties. Click the Ports tab.

(Control Panel > Devices and Printers > Right-click on your printer icon and select Printer properties)

If the port is set to File or LPT, uncheck them and select TCP/IP, USB, or WSD.
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Operating system problems

2 

Common Mac problems

 

 

 

Refer to the Mac User’s Guide that came with your computer for further information on Mac error messages.

 

Condition Suggested solutions

The machine does not print PDF files 
correctly. Some parts of graphics, text, or 
illustrations are missing.

Printing the PDF file as an image may enable the file to print. Turn on Print As Image from the Acrobat printing options. 

 

It will take longer to print when you print a PDF file as an image.

 

Some letters are not displayed normally 
during cover page printing.

Mac OS cannot create the font while printing the cover page. The English alphabet and numbers are displayed normally on 
the cover page.

When printing a document in Mac with 
Acrobat Reader 6.0 or higher, colors 
print incorrectly.

Make sure that the resolution setting in your machine driver matches the one in Acrobat Reader.
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Operating system problems

3 

Common Linux problems

 

 

 

Refer to the Linux User’s Guide that came with your computer for further information on Linux error messages.

 

Condition Suggested solutions

Unchecking the collate option 
in the Print Dialog does not 
work.

For some distributions, GNOME Print Dialog has an issue handling the collate option. As workaround, set the default value of collate 
option to False using the system's printing utility(execute "system-config-printer" in the Terminal program).

Printing always works with 
duplex.

This duplex issue was in Ubuntu 9.10 CUPS package. Update CUPS version to 1.4.1-5ubuntu2.2.

Printer is not added through 
system's printing utility.

The problem occurs on Debian 7 due to the defect in 'system-config-printer' package of the Debian 7 (http://bugs.debian.org/cgi-bin/
bugreport.cgi?bug=662813 in Debian bug tracking system). Please use another way to add printer (CUPS WebUI for example)

Paper size and orientation are 
disabled in the Print Dialog 
when opening text files.

The problem occurs on Fedora 19 and it's related to 'leafpad' text editor on Fedora 19. Please use other text editors like 'gedit'.

Printing produces divided 
images.

 This issue exists in openSUSE 13.2 due to wrong ghostscript provided by the system. Update 'cups-filters-ghostscript' package with the 
command "zypper install --force cups-filters-ghostscript" or with "Install/Remove Software" utility.
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Contact SAMSUNG worldwide

If you have any comments or questions regarding Samsung products, contact 
the Samsung customer care center.

Country/Region Customer Care Center WebSite

ALGERIA
021 36 11 00 www.samsung.com/

n_africa/support

ARGENTINE
0800-555-SAMSUNG 

(0800-555-7267) 

www.samsung.com/
ar/support

ARMENIA
0-800-05-555 www.samsung.com/

support

AUSTRALIA
1300 362 603 www.samsung.com/

au/support

AUSTRIA

0800-SAMSUNG (0800-7267864)

[Only for Premium HA] 0800-
366661

[Only for Dealers] 0810-112233

www.samsung.com/
at/support

AZERBAIJAN
0-88-555-55-55 www.samsung.com/

support

BAHRAIN

8000-GSAM (8000-4726) www.samsung.com/
ae/support (English)

www.samsung.com/
ae_ar/support (Arabic)

BELARUS
810-800-500-55-500 www.samsung.com/

support

BANGLADESH
09612300300 www.samsung.com/

in/support

BELGIUM

02-201-24-18 www.samsung.com/
be/support (Dutch)

www.samsung.com/
be_fr/support (French)

BOLIVIA
800-10-7260

[HHP] 4828210

www.samsung.com/
cl/support

BOSNIA
055 233 999 www.samsung.com/

support

BOTSWANA
8007260000 www.samsung.com/

support

BRAZIL

0800-124-421 (Demais cidades e 
regiões)

4004-0000 (Capitais e grandes 
centros)

www.samsung.com/
br/support

BULGARIA
800 111 31 , Безплатна 
телефонна линия

www.samsung.com/
bg/support

BURUNDI
200 www.samsung.com/

support

CAMEROON
7095- 0077 www.samsung.com/

africa_fr/support

Country/Region Customer Care Center WebSite
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Contact SAMSUNG worldwide
CANADA

1-800-SAMSUNG (726-7864) www.samsung.com/
ca/support(English)

www.samsung.com/
ca_fr/support (French)

CHILE
800-SAMSUNG (726-7864)

[HHP] 02-24828200

www.samsung.com/
cl/support

CHINA
400-810-5858 www.samsung.com/

cn/support

COLOMBIA

Bogotá 600 12 72

Gratis desde cualquier parte del 
país 01 8000 112 112 ó  desde su 
celular #SAM(726)

www.samsung.com/
co/support

COSTA RICA

0-800-507-7267

 00-800-1-SAMSUNG (726-7864)

www.samsung.com/
latin/support 
(Spanish)

www.samsung.com/
latin_en/support 
(English)

CROATIA
072 726 786 www.samsung.com/

hr/support

Cote D’ Ivoire
8000 0077 www.samsung.com/

africa_fr/support

Country/Region Customer Care Center WebSite

CYPRUS
8009 4000 only from landline, toll 
free

www.samsung.com/
gr/support

CZECH
800-SAMSUNG (800-726786) www.samsung.com/

cz/support

DENMARK
70 70 19 70 www.samsung.com/

dk/support

DOMINICAN 
REPUBLIC

1-800-751-2676 www.samsung.com/
latin/support 
(Spanish)

www.samsung.com/
latin_en/support 
(English)

DRC
499999 www.samsung.com/

support

ECUADOR

1-800-10-7267

1-800-SAMSUNG (72-6786)

www.samsung.com/
latin/support 
(Spanish)

www.samsung.com/
latin_en/
support(English)

EGYPT
08000-7267864

16580

www.samsung.com/
eg/support

Country/Region Customer Care Center WebSite
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Contact SAMSUNG worldwide
EIRE
0818 717100 www.samsung.com/

ie/support

EL SALVADOR

800-6225

800-0726-7864

www.samsung.com/
latin/support 
(Spanish)

www.samsung.com/
latin_en/support 
(English)

ESTONIA
800-7267 www.samsung.com/

ee/support

FINLAND
030-6227 515 www.samsung.com/fi/

support

FRANCE
01 48 63 00 00 www.samsung.com/

fr/support

GERMANY

0180 6 SAMSUNG bzw. 

0180 6 7267864*

 [HHP] 0180 6 M SAMSUNG bzw.

0180 6 67267864* (*0,20 €/Anruf 
aus dem dt. Festnetz, aus dem 
Mobilfunk max. 0,60 €/Anruf)

www.samsung.com/
de/support

GEORGIA
0-800-555-555 www.samsung.com/

support

Country/Region Customer Care Center WebSite

GHANA
0800-10077

0302-200077

www.samsung.com/
africa_en/support

GREECE

80111-SAMSUNG (80111 726 
7864) only from land line

(+30) 210 6897691 from mobile 
and land line

www.samsung.com/
gr/support

GUATEMALA

1-800-299-0013

1-800-299-0033

www.samsung.com/
latin/support 
(Spanish)

www.samsung.com/
latin_en/support 
(English)

HONDURAS

800-2791-9267 

800-2791-9111

www.samsung.com/
latin/support 
(Spanish)

www.samsung.com/
latin_en/support 
(English)

HONG KONG

(852) 3698 4698 www.samsung.com/
hk/support (Chinese)

www.samsung.com/
hk_en/support 
(English)

Country/Region Customer Care Center WebSite
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Contact SAMSUNG worldwide
HUNGARY
0680SAMSUNG (0680-726-786)

0680PREMIUM (0680-773-648)

www.samsung.com/
hu/support

INDIA
1800 3000 8282 - Toll Free

1800 266 8282 - Toll Free

www.samsung.com/
in/support

INDONESIA
021-56997777

08001128888

www.samsung.com/
id/support

IRAN
021-8255 [CE]

021-42132 [HHP]

www.samsung.com/
iran/support

ITALIA

800-SAMSUNG (800.7267864)

[HHP] 800.Msamsung 
(800.67267864)

www.samsung.com/
it/support

JAMAICA
1-800-234-7267

1-800-SAMSUNG (726-7864)

www.samsung.com/
latin_en/support 
(English)

JAPAN
0120-363-905 www.samsung.com/

jp/support

JORDAN
0800-22273

06 5777444

www.samsung.com/
levant/support 
(English)

KAZAKHSTAN
8-10-800-500-55-500 (GSM:7799, 
VIP care 7700)

www.samsung.com/
support

Country/Region Customer Care Center WebSite

KENYA
0800 545 545 www.samsung.com/

support

KUWAIT

183-CALL (183-2255) www.samsung.com/
ae/support (English)

www.samsung.com/
ae_ar/support (Arabic)

KYRGYZSTAN
00-800-500-55-500 www.samsung.com/

kz_ru/support

LATVIA
8000-7267 www.samsung.com/

lv/support

LITHUANIA
8-800-77777 www.samsung.com/

lt/support

LUXEMBURG
261 03 710 www.samsung.com/

support

MACAU
0800 333 www.samsung.com/

support

MACEDONIA 023 207 777

MALAYSIA

1800-88-9999

603-77137477 (Overseas 
contact)

www.samsung.com/
my/support

MAURITIUS
23052574020 www.samsung.com/

support

Country/Region Customer Care Center WebSite
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http://www.samsung.com/hu/support
http://www.samsung.com/in/support
http://www.samsung.com/id/support
http://www.samsung.com/iran/support
http://www.samsung.com/it/support
http://www.samsung.com/latin_en/support
http://www.samsung.com/jp/support
http://www.samsung.com/levant/support 
http://www.samsung.com/support
http://www.samsung.com/support
http://www.samsung.com/ae/support 
http://www.samsung.com/ae_ar/support
http://www.samsung.com/kz_ru/support
http://www.samsung.com/lv/support
http://www.samsung.com/lt/support
http://www.samsung.com/support
http://www.samsung.com/support
http://www.samsung.com/my/support
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MEXICO
01-800-SAMSUNG (726-7864) www.samsung.com/

mx/support

MOLDOVA
0-800-614-40 www.samsung.com/

support

MONGOLIA
+7-495-363-17-00 www.samsung.com/

support

MONTENEGRO
020 405 888 www.samsung.com/

support

MOROCCO
080 100 2255 www.samsung.com/

n_africa/support

MOZAMBIQUE
847267864 / 827267864 www.samsung.com/

support

MYANMAR
+95-01-2399-888 www.samsung.com/

support

NAMIBIA
08 197 267 864 www.samsung.com/

support

NIGERIA
0800-726-7864 www.samsung.com/

africa_en/support

NETHERLANDS
0900-SAMSUNG (0900-7267864) 
(€ 0,10/Min)

www.samsung.com/
nl/support

NEW ZEALAND
 0800 726 786 www.samsung.com/

nz/support

Country/Region Customer Care Center WebSite

NICARAGUA

001-800-5077267 www.samsung.com/
latin/support(Spanish)

www.samsung.com/
latin_en/support 
(English)

NORWAY
815 56480 www.samsung.com/

no/support

OMAN

800-SAMSUNG (800 - 726 7864) www.samsung.com/
ae/support (English)

www.samsung.com/
ae_ar/support (Arabic)

PAKISTAN
0800-Samsung (72678) www.samsung.com/

pk/support

PANAMA

800-7267

800-0101

www.samsung.com/
latin/support 
(Spanish)

www.samsung.com/
latin_en/support 
(English)

Country/Region Customer Care Center WebSite
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http://www.samsung.com/mx/support
http://www.samsung.com/support
http://www.samsung.com/support
http://www.samsung.com/support
http://www.samsung.com/n_africa/support
http://www.samsung.com/support
http://www.samsung.com/support
http://www.samsung.com/support
http://www.samsung.com/africa_en/support
http://www.samsung.com/nl/support
http://www.samsung.com/nz/support
http://www.samsung.com/latin/support
http://www.samsung.com/latin_en/support 
http://www.samsung.com/no/support
http://www.samsung.com/ae/support 
http://www.samsung.com/ae_ar/support 
http://www.samsung.com/pk/support
http://www.samsung.com/latin/support 
http://www.samsung.com/latin_en/support 
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PARAGUAY

009-800-542-0001 www.samsung.com/
latin/support 
(Spanish)

www.samsung.com/
latin_en/support 
(English)

PERU
0800-777-08 www.samsung.com/

pe/support

PHILIPPINES

1-800-10-7267864 [PLDT]

1-800-8-7267864 [Globe landline 
and Mobile]

02-4222111 [Other landline]

www.samsung.com/
ph/support

POLAND

801-172-678* lub +48 22 607-93-
33 *

[HHP] 801-672-678* lub +48 22 
607-93-33*

* (koszt połączenia według taryfy 
operatora)

www.samsung.com/
pl/support

PORTUGAL
808 20 7267 www.samsung.com/

pt/support

Country/Region Customer Care Center WebSite

PUERTO RICO

1-800-682-3180 www.samsung.com/
latin/support 
(Spanish)

www.samsung.com/
latin_en/support 
(English)

QATAR

800-CALL (800-2255) www.samsung.com/
ae/support (English)

www.samsung.com/
ae_ar/support (Arabic)

REUNION
262508869 www.samsung.com/

support

RWANDA
9999 www.samsung.com/

support

ROMANIA

08008 726 78 64 (08008 
SAMSUNG )

Apel GRATUIT

www.samsung.com/
ro/support

RUSSIA
8-800-555-55-55 (VIP care 8-800-
555-55-88)

www.samsung.com/
ru/support

SAUDI ARABIA

8002474357 www.samsung.com/
sa/support

www.samsung.com/
sa_en/support 
(English)/

Country/Region Customer Care Center WebSite
195 Contact SAMSUNG worldwide

http://www.samsung.com/latin/support 
http://www.samsung.com/latin_en/support 
http://www.samsung.com/pe/support
http://www.samsung.com/ph/support
http://www.samsung.com/pl/support
http://www.samsung.com/pt/support
http://www.samsung.com/latin/support
http://www.samsung.com/latin_en/support
http://www.samsung.com/ae/support 
http://www.samsung.com/ae_ar/support 
http://www.samsung.com/support
http://www.samsung.com/support
http://www.samsung.com/ro/support
http://www.samsung.com/ru/support
http://www.samsung.com/sa/support


Contact SAMSUNG worldwide
SENEGAL
800-00-0077 www.samsung.com/

africa_fr/support

SERBIA
011 321 6899 www.samsung.com/

rs/support

SINGAPORE
1800-SAMSUNG (726-7864) www.samsung.com/

sg/support

SLOVENIA
080 697 267 (brezplačna številka)

 090 726 786 (0,39 EUR/min)

www.samsung.com/
rs/si

SLOVAKIA
0800 - SAMSUNG(0800-726 786) www.samsung.com/

sk/support

SOUTH AFRICA
0860 SAMSUNG (726 7864) www.samsung.com/

support

SPAIN
0034902172678

[HHP] 0034902167267

www.samsung.com/
es/support

SRI LANKA
94117540540 www.samsung.com/

support

SUDAN
1969 www.samsung.com/

support

SWEDEN
0771 726 7864 (0771-SAMSUNG) www.samsung.com/

se/support

Country/Region Customer Care Center WebSite

SWITZERLAND

0800 726 78 64 (0800-SAMSUNG) www.samsung.com/
ch/support (German)

www.samsung.com/
ch_fr/support (French)

SYRIA
18252273 www.samsung.com/

levant/support 
(English)

TADJIKISTAN
8-10-800-500-55-500 www.samsung.com/

support

TAIWAN
0800-329999 www.samsung.com/

tw/support

TANZANIA
0800 755 755

0685 889 900

www.samsung.com/
support

THAILAND
0-2689-3232,

1800-29-3232

www.samsung.com/
th/support

TRINIDAD & 
TOBAGO

1-800-SAMSUNG (726-7864)  www.samsung.com/
latin/support 
(Spanish)

www.samsung.com/
latin_en/support 
(English)

TURKEY
444 77 11 www.samsung.com/

tr/support

Country/Region Customer Care Center WebSite
196 Contact SAMSUNG worldwide

http://www.samsung.com/africa_fr/support
http://www.samsung.com/rs/support
http://www.samsung.com/sg/support
http://www.samsung.com/rs/si
http://www.samsung.com/sk/support
http://www.samsung.com/support
http://www.samsung.com/es/support
http://www.samsung.com/support
http://www.samsung.com/support
http://www.samsung.com/se/support
http://www.samsung.com/ch/support 
http://www.samsung.com/ch_fr/support 
http://www.samsung.com/levant/support 
http://www.samsung.com/support
http://www.samsung.com/tw/support
http://www.samsung.com/support
http://www.samsung.com/th/support
http://www.samsung.com/latin/support
http://www.samsung.com/latin_en/support
http://www.samsung.com/tr/support


Contact SAMSUNG worldwide
TUNISIA
80-1000-12  www.samsung.com/

n_africa/support

U.A.E

800-SAMSUNG (800 -726 7864)  www.samsung.com/
ae/support (English)

www.samsung.com/
ae_ar/support (Arabic)

UK
0330 SAMSUNG (7267864) www.samsung.com/

uk/support

U.S.A

-Consummer

 Electonics

1-800-SAMSUNG (726-7864) www.samsung.com/
us/support

U.S.A
(Mobile Phones)

1-800-SAMSUNG (72-6786)

[HHP] 1-888-987-HELP(4357)

www.samsung.com/
us/support

UGANDA
0800 300 300 www.samsung.com/

support

UKRAINE

0-800-502-000 www.samsung.com/
ua/support (Ukrainian)

www.samsung.com/
ua_ru/support 
(Russian)

Country/Region Customer Care Center WebSite

URUGUAY

000- 405-437-33 www.samsung.com/
latin/support(Spanish)

www.samsung.com/
latin_en/
support(English)

UZBEKISTAN
8-10-800-500-55-500 (GSM: 
7799)

www.samsung.com/
support

VENEZUELA
0-800-SAMSUNG (726-7864) www.samsung.com/

ve/support

VIETNAM
1800 588 889 www.samsung.com/

vn/support

ZAMBIA
0211  350370 www.samsung.com/

support

Country/Region Customer Care Center WebSite
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http://www.samsung.com/n_africa/support
http://www.samsung.com/ae/support
http://www.samsung.com/ae_ar/support 
http://www.samsung.com/uk/support
http://www.samsung.com/us/support
http://www.samsung.com/us/support
http://www.samsung.com/support
http://www.samsung.com/ua/support 
http://www.samsung.com/ua_ru/support
http://www.samsung.com/latin/support
http://www.samsung.com/latin_en/support
http://www.samsung.com/support
http://www.samsung.com/ve/support
http://www.samsung.com/vn/support
http://www.samsung.com/support


Glossary

 

The following glossary helps you get familiar with the product by 
understanding the terminologies commonly used with printing as well as 
mentioned in this user’s guide.

 

802.11

802.11 is a set of standards for wireless local area network (WLAN) 
communication, developed by the IEEE LAN/MAN Standards Committee (IEEE 
802). 

802.11b/g/n

802.11b/g/n can share same hardware and use the 2.4 GHz band. 802.11b 
supports bandwidth up to 11 Mbps, 802.11n supports bandwidth up to 150 
Mbps. 802.11b/g/n devices may occasionally suffer interference from 
microwave ovens, cordless telephones, and Bluetooth devices.

Access point

Access Point or Wireless Access Point (AP or WAP) is a device that connects 
wireless communication devices together on wireless local area networks 
(WLAN), and acts as a central transmitter and receiver of WLAN radio signals. 

ADF

An Automatic Document Feeder (ADF) is a scanning unit that will automatically 
feed an original sheet of paper so that the machine can scan some amount of the 
paper at once. 

AppleTalk

AppleTalk is a proprietary suite of protocols developed by Apple, Inc for 
computer networking. It was included in the original Mac (1984) and is now 
deprecated by Apple in favor of TCP/IP networking.

BIT Depth

A computer graphics term describing the number of bits used to represent the 
color of a single pixel in a bitmapped image. Higher color depth gives a broader 
range of distinct colors. As the number of bits increases, the number of possible 
colors becomes impractically large for a color map. 1-bit color is commonly 
called as monochrome or black and white.

BMP

A bitmapped graphics format used internally by the Microsoft Windows 
graphics subsystem (GDI), and used commonly as a simple graphics file format 
on that platform.
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BOOTP

Bootstrap Protocol. A network protocol used by a network client to obtain its IP 
address automatically. This is usually done in the bootstrap process of 
computers or operating systems running on them. The BOOTP servers assign 
the IP address from a pool of addresses to each client. BOOTP enables 'diskless 
workstation' computers to obtain an IP address prior to loading any advanced 
operating system.

CCD

Charge Coupled Device (CCD) is a hardware which enables the scan job. CCD 
Locking mechanism is also used to hold the CCD module to prevent any damage 
when you move the machine.

Collation

Collation is a process of printing a multiple-copy job in sets. When collation is 
selected, the device prints an entire set before printing additional copies.

Control Panel

A control panel is a flat, typically vertical, area where control or monitoring 
instruments are displayed. They are typically found in front of the machine. 

Coverage

It is the printing term used for a toner usage measurement on printing. For 
example, 5% coverage means that an A4 sided paper has about 5% image or text 
on it. So, if the paper or original has complicated images or lots of text on it, the 
coverage will be higher and at the same time, a toner usage will be as much as 
the coverage.

CSV

Comma Separated Values (CSV). A type of file format, CSV is used to exchange 
data between disparate applications. The file format, as it is used in Microsoft 
Excel, has become a de facto standard throughout the industry, even among 
non-Microsoft platforms.

DADF

A Duplex Automatic Document Feeder (DADF) is a scanning unit that will 
automatically feed and turn over an original sheet of paper so that the machine 
can scan on both sides of the paper.

Default

The value or setting that is in effect when taking a printer out of its box state, 
reset, or initialized.
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DHCP

A Dynamic Host Configuration Protocol (DHCP) is a client-server networking 
protocol. A DHCP server provides configuration parameters specific to the DHCP 
client host requesting, generally, information required by the client host to 
participate on an IP network. DHCP also provides a mechanism for allocation of 
IP addresses to client hosts.

DIMM

Dual Inline Memory Module (DIMM), a small circuit board that holds memory. 
DIMM stores all the data within the machine like printing data, received fax data.

DLNA

The Digital Living Network Alliance (DLNA) is a standard that allows devices on 
a home network to share information with each other across the network.

DNS

The Domain Name Server (DNS) is a system that stores information associated 
with domain names in a distributed database on networks, such as the Internet.

Dot Matrix Printer

A dot matrix printer refers to a type of computer printer with a print head that 
runs back and forth on the page and prints by impact, striking an ink-soaked 
cloth ribbon against the paper, much like a typewriter.

DPI

Dots Per Inch (DPI) is a measurement of resolution that is used for scanning and 
printing. Generally, higher DPI results in a higher resolution, more visible detail 
in the image, and a larger file size.

DRPD 

Distinctive Ring Pattern Detection. Distinctive Ring is a telephone company 
service which enables a user to use a single telephone line to answer several 
different telephone numbers.

Duplex

A mechanism that will automatically turn over a sheet of paper so that the 
machine can print (or scan) on both sides of the paper. A printer equipped with 
a Duplex Unit can print on both sides of paper during one print cycle.

Duty Cycle

Duty cycle is the page quantity which does not affect printer performance for a 
month. Generally the printer has the lifespan limitation such as pages per year. 
The lifespan means the average capacity of print-outs, usually within the 
warranty period. For example, if the duty cycle is 48,000 pages per month 
assuming 20 working days, a printer limits 2,400 pages a day.
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ECM

Error Correction Mode (ECM) is an optional transmission mode built into Class 1 
fax machines or fax modems. It automatically detects and corrects errors in the 
fax transmission process that are sometimes caused by telephone line noise.

Emulation

Emulation is a technique of one machine obtaining the same results as another.

An emulator duplicates the functions of one system with a different system, so 
that the second system behaves like the first system. Emulation focuses on exact 
reproduction of external behavior, which is in contrast to simulation, which 
concerns an abstract model of the system being simulated, often considering its 
internal state.

Ethernet

Ethernet is a frame-based computer networking technology for local area 
networks (LANs). It defines wiring and signaling for the physical layer, and frame 
formats and protocols for the media access control (MAC)/data link layer of the 
OSI model. Ethernet is mostly standardized as IEEE 802.3. It has become the most 
widespread LAN technology in use during the 1990s to the present.

EtherTalk

A suite of protocols developed by Apple Computer for computer networking. It 
was included in the original Mac (1984) and is now deprecated by Apple in favor 
of TCP/IP networking. 

FDI

Foreign Device Interface (FDI) is a card installed inside the machine to allow a 
third party device such as a coin operated device or a card reader. Those devices 
allow the pay-for-print service on your machine.

FTP

A File Transfer Protocol (FTP) is a commonly used protocol for exchanging files 
over any network that supports the TCP/IP protocol (such as the Internet or an 
intranet).

Fuser Unit 

The part of a laser printer that fuses the toner onto the print media. It consists of 
a heat roller and a pressure roller. After toner is transferred onto the paper, the 
fuser unit applies heat and pressure to ensure that the toner stays on the paper 
permanently, which is why paper is warm when it comes out of a laser printer.
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Gateway

A connection between computer networks, or between a computer network 
and a telephone line. It is very popular, as it is a computer or a network that 
allows access to another computer or network.

Grayscale

A shades of gray that represents light and dark portions of an image when color 
images are converted to grayscale; colors are represented by various shades of 
gray.

Halftone

An image type that simulates grayscale by varying the number of dots. Highly 
colored areas consist of a large number of dots, while lighter areas consist of a 
smaller number of dots.

HDD

Hard Disk Drive (HDD), commonly referred to as a hard drive or hard disk, is a 
non-volatile storage device which stores digitally-encoded data on rapidly 
rotating platters with magnetic surfaces.

IEEE

The Institute of Electrical and Electronics Engineers (IEEE) is an international 
non-profit, professional organization for the advancement of technology 
related to electricity.

IEEE 1284

The 1284 parallel port standard was developed by the Institute of Electrical and 
Electronics Engineers (IEEE). The term "1284-B" refers to a specific connector 
type on the end of the parallel cable that attaches to the peripheral (for example, 
a printer). 

Intranet

A private network that uses Internet Protocols, network connectivity, and 
possibly the public telecommunication system to securely share part of an 
organization's information or operations with its employees. Sometimes the 
term refers only to the most visible service, the internal website.

IP address

An Internet Protocol (IP) address is a unique number that devices use in order to 
identify and communicate with each other on a network utilizing the Internet 
Protocol standard.
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IPM

The Images Per Minute (IPM) is a way of measuring the speed of a printer. An IPM 
rate indicates the number of single-sided sheets a printer can complete within 
one minute.

IPP

The Internet Printing Protocol (IPP) defines a standard protocol for printing as 
well as managing print jobs, media size, resolution, and so forth. IPP can be used 
locally or over the Internet to hundreds of printers, and also supports access 
control, authentication, and encryption, making it a much more capable and 
secure printing solution than older ones.

IPX/SPX

IPX/SPX stands for Internet Packet Exchange/Sequenced Packet Exchange. It is a 
networking protocol used by the Novell NetWare operating systems. IPX and 
SPX both provide connection services similar to TCP/IP, with the IPX protocol 
having similarities to IP, and SPX having similarities to TCP. IPX/SPX was 
primarily designed for local area networks (LANs), and is a very efficient protocol 
for this purpose (typically its performance exceeds that of TCP/IP on a LAN).

ISO

The International Organization for Standardization (ISO) is an international 
standard-setting body composed of representatives from national standards 
bodies. It produces world-wide industrial and commercial standards.

ITU-T

The International Telecommunication Union is an international organization 
established to standardize and regulate international radio and 
telecommunications. Its main tasks include standardization, allocation of the 
radio spectrum, and organizing interconnection arrangements between 
different countries to allow international phone calls. A -T out of ITU-T indicates 
telecommunication.

ITU-T No. 1 chart

Standardized test chart published by ITU-T for document facsimile 
transmissions.

JBIG

Joint Bi-level Image Experts Group (JBIG) is an image compression standard with 
no loss of accuracy or quality, which was designed for compression of binary 
images, particularly for faxes, but can also be used on other images.

JPEG

Joint Photographic Experts Group (JPEG) is a most commonly used standard 
method of lossy compression for photographic images. It is the format used for 
storing and transmitting photographs on the World Wide Web.
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LDAP

The Lightweight Directory Access Protocol (LDAP) is a networking protocol for 
querying and modifying directory services running over TCP/IP.

LED

A Light-Emitting Diode (LED) is a semiconductor device that indicates the status 
of a machine.

MAC address

Media Access Control (MAC) address is a unique identifier associated with a 
network adapter. MAC address is a unique 48-bit identifier usually written as 12 
hexadecimal characters grouped in pairs (e. g., 00-00-0c-34-11-4e). This address 
is usually hard-coded into a Network Interface Card (NIC) by its manufacturer, 
and used as an aid for routers trying to locate machines on large networks.

MFP

Multi Function Peripheral (MFP) is an office machine that includes the following 
functionality in one physical body, so as to have a printer, a copier, a fax, a 
scanner and etc.

MH

Modified Huffman (MH) is a compression method for decreasing the amount of 
data that needs to be transmitted between the fax machines to transfer the 
image recommended by ITU-T T.4. MH is a codebook-based run-length 
encoding scheme optimized to efficiently compress white space. As most faxes 
consist mostly of white space, this minimizes the transmission time of most 
faxes. 

MMR

Modified Modified READ (MMR) is a compression method recommended by ITU-
T T.6.

Modem

A device that modulates a carrier signal to encode digital information, and also 
demodulates such a carrier signal to decode transmitted information.

MR

Modified Read (MR) is a compression method recommended by ITU-T T.4. MR 
encodes the first scanned line using MH. The next line is compared to the first, 
the differences determined, and then the differences are encoded and 
transmitted.
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NetWare

A network operating system developed by Novell, Inc. It initially used 
cooperative multitasking to run various services on a PC, and the network 
protocols were based on the archetypal Xerox XNS stack. Today NetWare 
supports TCP/IP as well as IPX/SPX.

OPC

Organic Photo Conductor (OPC) is a mechanism that makes a virtual image for 
print using a laser beam emitted from a laser printer, and it is usually green or 
rust colored and has a cylinder shape. 

An imaging unit containing a drum slowly wears the drum surface by its usage 
in the printer, and it should be replaced appropriately since it gets worn from 
contact with the cartridge development brush, cleaning mechanism, and paper.

Originals

The first example of something, such as a document, photograph or text, etc, 
which is copied, reproduced or translated to produce others, but which is not 
itself copied or derived from something else.

OSI

Open Systems Interconnection (OSI) is a model developed by the International 
Organization for Standardization (ISO) for communications. OSI offers a 
standard, modular approach to network design that divides the required set of 
complex functions into manageable, self-contained, functional layers. The layers 
are, from top to bottom, Application, Presentation, Session, Transport, Network, 
Data Link and Physical.

PABX 

A private automatic branch exchange (PABX) is an automatic telephone 
switching system within a private enterprise.

PCL

Printer Command Language (PCL) is a Page Description Language (PDL) 
developed by HP as a printer protocol and has become an industry standard. 
Originally developed for early inkjet printers, PCL has been released in varying 
levels for thermal, dot matrix printer, and laser printers.

PDF

Portable Document Format (PDF) is a proprietary file format developed by 
Adobe Systems for representing two dimensional documents in a device 
independent and resolution independent format.
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PostScript

PostScript (PS) is a page description language and programming language used 
primarily in the electronic and desktop publishing areas. - that is run in an 
interpreter to generate an image.

Printer Driver

A program used to send commands and transfer data from the computer to the 
printer.

Print Media

The media like paper, labels, and transparencies which can be used in a printer, 
a scanner, a fax or, a copier.

PPM

Pages Per Minute (PPM) is a method of measurement for determining how fast 
a printer works, meaning the number of pages a printer can produce in one 
minute.

PRN file

An interface for a device driver, this allows software to interact with the device 
driver using standard input/output system calls, which simplifies many tasks. 

Protocol

A convention or standard that controls or enables the connection, 
communication, and data transfer between two computing endpoints.

PS

See PostScript.

PSTN

The Public-Switched Telephone Network (PSTN) is the network of the world's 
public circuit-switched telephone networks which, on industrial premises, is 
usually routed through the switchboard.

RADIUS

Remote Authentication Dial In User Service (RADIUS) is a protocol for remote 
user authentication and accounting. RADIUS enables centralized management 
of authentication data such as usernames and passwords using an AAA 
(authentication, authorization, and accounting) concept to manage network 
access.

Resolution

The sharpness of an image, measured in Dots Per Inch (DPI). The higher the dpi, 
the greater the resolution.
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SMB

Server Message Block (SMB) is a network protocol mainly applied to share files, 
printers, serial ports, and miscellaneous communications between nodes on a 
network. It also provides an authenticated Inter-process communication 
mechanism.

SMTP

Simple Mail Transfer Protocol (SMTP) is the standard for e-mail transmissions 
across the Internet. SMTP is a relatively simple, text-based protocol, where one 
or more recipients of a message are specified, and then the message text is 
transferred. It is a client-server protocol, where the client transmits an email 
message to the server.

SSID

Service Set Identifier (SSID) is a name of a wireless local area network (WLAN). All 
wireless devices in a WLAN use the same SSID in order to communicate with 
each other. The SSIDs are case-sensitive and have a maximum length of 32 
characters.

Subnet Mask 

The subnet mask is used in conjunction with the network address to determine 
which part of the address is the network address and which part is the host 
address.

TCP/IP

The Transmission Control Protocol (TCP) and the Internet Protocol (IP); the set of 
communications protocols that implement the protocol stack on which the 
Internet and most commercial networks run.

TCR

Transmission Confirmation Report (TCR) provides details of each transmission 
such as job status, transmission result and number of pages sent. This report can 
be set to print after each job or only after failed transmissions.

TIFF

Tagged Image File Format (TIFF) is a variable-resolution bitmapped image 
format. TIFF describes image data that typically come from scanners. TIFF 
images make use of tags, keywords defining the characteristics of the image that 
is included in the file. This flexible and platform-independent format can be 
used for pictures that have been made by various image processing 
applications.

Toner Cartridge

A kind of bottle or container used in a machine like a printer which contains 
toner. Toner is a powder used in laser printers and photocopiers, which forms 
the text and images on the printed paper. Toner can be fused by a combination 
of heat/pressure from the fuser, causing it to bind to the fibers in the paper.
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TWAIN

An industry standard for scanners and software. By using a TWAIN-compliant 
scanner with a TWAIN-compliant program, a scan can be initiated from within 
the program. It is an image capture API for Microsoft Windows and Apple Mac 
operating systems.

UNC Path

Uniform Naming Convention (UNC) is a standard way to access network shares 
in Window NT and other Microsoft products. The format of a UNC path is: 
\\<servername>\<sharename>\<Additional directory>

URL

Uniform Resource Locator (URL) is the global address of documents and 
resources on the Internet. The first part of the address indicates what protocol to 
use, the second part specifies the IP address or the domain name where the 
resource is located.

USB

Universal Serial Bus (USB) is a standard that was developed by the USB 
Implementers Forum, Inc., to connect computers and peripherals. Unlike the 
parallel port, USB is designed to concurrently connect a single computer USB 
port to multiple peripherals.

Watermark

A watermark is a recognizable image or pattern in paper that appears lighter 
when viewed by transmitted light. Watermarks were first introduced in Bologna, 
Italy in 1282; they have been used by papermakers to identify their product, and 
also on postage stamps, currency, and other government documents to 
discourage counterfeiting.

WEP

Wired Equivalent Privacy (WEP) is a security protocol specified in IEEE 802.11 to 
provide the same level of security as that of a wired LAN. WEP provides security 
by encrypting data over radio so that it is protected as it is transmitted from one 
end point to another.

WIA

Windows Imaging Architecture (WIA) is an imaging architecture that is originally 
introduced in Windows Me and Windows XP. A scan can be initiated from within 
these operating systems by using a WIA-compliant scanner.

WPA

Wi-Fi Protected Access (WPA) is a class of systems to secure wireless (Wi-Fi) 
computer networks, which was created to improve upon the security features of 
WEP.
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WPA-PSK

WPA-PSK (WPA Pre-Shared Key) is special mode of WPA for small business or 
home users. A shared key, or password, is configured in the wireless access point 
(WAP) and any wireless laptop or desktop devices. WPA-PSK generates a unique 
key for each session between a wireless client and the associated WAP for more 
advanced security.

WPS

The Wi-Fi Protected Setup (WPS) is a standard for establishing a wireless home 
network. If your wireless access point supports WPS, you can configure the 
wireless network connection easily without a computer.

XPS

XML Paper Specification (XPS) is a specification for a Page Description Language 
(PDL) and a new document format, which has benefits for portable document 
and electronic document, developed by Microsoft. It is an XML-based 
specification, based on a new print path and a vector-based device-
independent document format.
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